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Readiris 17 

Welcome to the Readiris documentation. 

The aim of this documentation is to help you get up to speed with using Readiris. It covers Readiris' 

installation and setup, the basic processing steps and the application's commands and working areas. At 

the end of the documentation you find an How to section in which particular questions are addressed. 

The procedures described in this documentation are based on the Windows 7 and Windows 10 operating 

systems. 

This documentation is written with the assumption that you know how to work in a Microsoft Windows 

environment. Consult your Windows documentation if necessary, in case you are not familiar with menu 

commands, dialog boxes, drop-down lists, docking windows and so on. 

The information in this documentation is subject to change without prior notice. 

For additional information about Readiris, open the Help menu. There, you have access to Getting Started 

videos, a Knowledge Base, I.R.I.S. support, etc. 

 Readiris offers various features that come unlocked depending on the license number that is 

purchased. Three editions are available: Readiris PDF, Pro or Corporate. This documentation describes 

all the features available in the Corporate Edition. To verify what features are covered by your purchased 

edition, please see the comparison table on our website at http://www.irislink.com/ri17table.  

You can easily upgrade your license number if needed. 

Introducing Readiris 

Readiris is I.R.I.S.' flagship document recognition software. With Readiris you can scan paper documents, 

open Microsoft Office documents, image files and digital camera images and turn them into fully editable 

text documents and text-searchable PDF documents you can save, share and send to the Cloud. Readiris 

supports a wide range of output formats, the most important ones being Microsoft Word, Microsoft Excel 

and PDF. 

The documents Readiris generates can either be saved on your computer, directly sent via e-mail or 

exported to Cloud applications such as Evernote, Dropbox, Google Drive, Box and OneDrive. With Readiris 

Corporate you can also send documents to Microsoft SharePoint, Therefore, IRISNext and FTP. 

Readiris recognizes documents in 137 languages. All American and European languages, including the 

Central-European, Baltic and Cyrillic languages as well as Greek and Turkish are supported. Readiris also 

recognizes Arabic, Farsi and Hebrew, as well as four Asian languages: Japanese, Simplified and Traditional 

Chinese and Korean. 

Besides text recognition, Readiris offers powerful compression features for PDF and XPS files, thanks to 

I.R.I.S.' compression technology iHQC. 

http://www.irislink.com/ri17table
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What's new in Readiris 17 

Adding Annotations exportable in the PDF output format 

An annotation associates an object such as a note, sound, or text with a location on a page of a document.  

Readiris includes a PDF Annotations tab that allows you to add annotations in your documents before you 

export them into a PDF format. That function can be useful in a revision process.  

Among the annotation types supported is the Text to Speech (TTS) annotation.  

Other Output formats than PDF do not support annotations. Those annotations are fully compatible with 

Adobe Reader. The best result cannot be guaranteed with any another PDF viewer.  

  

MP3 Output Format 

A new available output format is MP3 (compressed audio format).  

  

JPEG Output Format 

The JPEG output format allows one page/image per file only. 

  

Improved performances 

A new OCR engine increases the quality and the speed of the character recognition. 
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Legal Notices 

RI_17_sjo_20180701_01 

Copyright 

© 2018 I.R.I.S. All Rights Reserved. 

  

I.R.I.S. owns the copyrights to the Readiris software, to the online help system and to this publication. 

The information contained in this document is the property of I.R.I.S. Its content is subject to change 

without notice and does not represent a commitment on the part of I.R.I.S. The software described in this 

document is furnished under a license agreement which states the terms of use of this product. The 

software may be used or copied only in accordance with the terms of that agreement. No part of this 

publication may be reproduced, transmitted, stored in a retrieval system, or translated into another 

language without the prior written consent of I.R.I.S. 

This documentation uses fictitious names as examples; references to actual persons, companies or 

organizations are strictly coincidental. 

Trademarks 

The Readiris logo and Readiris are trademarks of Image Recognition Integrated Systems S.A. 

OCR and barcode technology by I.R.I.S. 

AutoFormat and Linguistic technology by I.R.I.S. 

BCR and field analysis technology by I.R.I.S. 

iHQC compression technology by I.R.I.S. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

All other products mentioned in this documentation are trademarks or registered trademarks of their 

respective owners. 

Patent Statements 

Readiris is protected under these issued patents: US8068684; EP2143039; JP5501958B2; US8331706; 

US8666185; US8995780; BE1022635; US8913836; BE1021013; US9058517; US9311558; BE1022630; 

US8897600; US9183636; BE1022636; US8811751; BE1022166; BE1022562; US9798943; BE1024194; 

US9836646; applied for by I.R.I.S. SA.  

Third Party Software Acknowledgements 

Readiris for Windows® utilizes third-party software subject to the licenses described below. 

OSS 

Description Version License 

Podofo* 0.9.5.0 LGPL, version 2 

FreeImage  3.17 FIPL  

Lame*(www.mp3dev.org) 3.1 LGPL,version 2 

Boost   Boost Software License  

Zlib   Zlib License  

Minizip   Custom  

https://sourceforge.net/projects/podofo/
https://www.gnu.org/licenses/old-licenses/lgpl-2.0.html
http://freeimage.sourceforge.net/
http://freeimage.sourceforge.net/freeimage-license.txt
https://github.com/gypified/libmp3lame
https://www.gnu.org/licenses/old-licenses/lgpl-2.0.html
http://www.boost.org/users/license.html
http://zlib.net/zlib_license.html
http://www.winimage.com/zLibDll/minizip.html
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Pugxml   MIT  

Freetype   Freetype License  

Commercial Software Products or Components 

Description     

Aspose PDF for .Net      

Aspose Words for .Net      

BCGControlBar      

*Since the free library is subject to the LGPL, it is possible for any user to modify, recompile or replace the 

free LGPL library (here, podofo.dll and libmp3lame.dll) and use its modified version with Readiris. 

Disclaimer 

The content of this document was created and arranged with the utmost care.  

I.R.I.S. SA assumes no responsibility for the accuracy, completeness and timeliness of the provided 

content. 

  

https://pugixml.org/license.html
http://git.savannah.gnu.org/cgit/freetype/freetype2.git/tree/docs/FTL.TXT
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Section 1: Installation and Activation 

System Requirements 

The minimum system requirements to install and run Readiris are: 

  

Component Requirement 

Computer and 

processor 

1GHz processor or higher. A Multi-Core processor is recommended. 

Note: when your computer is equipped with a multi-core processor, Readiris uses the 

multiple cores to achieve faster processing. 

  

Memory Minimum 1 GB RAM. 2 GB RAM is recommended. 

Hard disk 
Minimum 400 MB free hard disk space*. 

1 GB free hard disk space is recommended. 

Operating System 

Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Vista, Windows XP (as of 

Service Pack 3). All 32 or 64 bit. 

Windows 7 or higher is recommended. 

Other 

Internet connection for the download version and the software activation. 

Note: some scanner drivers may not work under the latest version(s) of Windows. See 

the documentation supplied with your scanner to find out which platforms are 

supported. 

*During the installation the required disk space is double because of temporary files that need to be stored. 
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Installing Readiris 

Before you try and install Readiris, make sure you have the necessary administrator rights to install 

applications on your computer. 

To install Readiris: 

• Download your software package on http://www.irislink.com/softwaredownload.  

If your Readiris was bundled with IRIScan scanners, make sure to download the software package of 

your scanner: it will include Readiris.  

• Double-click the installation file to start the Installation Wizard. 

• Select the installation language and click OK. 

• Accept the terms of the license agreement. 

• A complete installation is selected by default. 

In case you only want to install certain recognition languages: 

• Select Custom and click Next. 

• Click the down arrow in front of Languages and select This feature will not be 

available. 

All languages are now unselected. 

 

• Now click the down arrow in front of the language(s) you want to install, and select This 

feature will be installed on local hard drive. 

• Click Next and follow the on-screen instructions. 

• Click Finish to complete the installation. 

The submenu IRIS > Readiris in the Windows Programs list is created automatically by the 

installation program. 

The installation program also creates a shortcut to the Readiris application on the Windows desktop. 

 

http://www.irislink.com/softwaredownload
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Activating Readiris 

Once you have installed Readiris you need to activate it. 

Note: Unactivated copies of Readiris allow you to convert a maximum of 150 pages during a period 

of 10 days, for documents of 10 pages maximum at a time (trial mode). 

To activate Readiris: 

• Double-click the Readiris shortcut on the Desktop to start. 

• You are prompted to activate Readiris. Click Yes to do so. 

Note that an internet connection is required to activate Readiris. 

• Enter the activation code you find on the label inside the product box. 

Note: if you downloaded an electronic version, your activation code was sent to you by email. 

• Then click Activate now to finish the activation. 

You can also choose to start the trial if you do not want to activate Readiris at this time. Fill in 

the form and click Continue. Next time you start Readiris you will be prompted again to 

activate the software. 

 

Tip: if an error occurs during the activation process, note that you can also do a manual 

activation. 

 

If errors keep occurring, you might need to deactivate your firewall and try again. Consult the Windows 

help file if necessary. To do so, press F1 on your keyboard while you are on the Desktop. 



Section 1: Installation and Activation 

8 

Software Registration 

Once you have activated your software you can also register it. 

Registering is required to get Technical Support. It also offers other benefits, such as free updates, free 

trial downloads, video tutorials, discount on new products, and so on. 

To register Readiris: 

• Click the Help tab. 

• Click Register Readiris. 

 

• Fill in the Registration form and click Register now. 

Note that an internet connection is required to register. 
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Search for updates 

When you register your copy of Readiris you are entitled to free software updates. 

To check if updates are available: 

• Click the Help tab. 

• Then click Search for updates. 

Note: Readiris automatically checks for updates every 20 days. 
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Uninstalling Readiris 

Should you want to remove Readiris from your computer, follow the procedure below. 

To uninstall the application: 

• Close Readiris. 

• From the Windows Start menu, go to the Control Panel. 

• Click Programs and Features. 

• Then select Readiris from the list and click Uninstall. 

 

  

Note: On Windows 10, go to Settings/System/Apps & features. Select Readiris and Click Uninstall. 



RI_17_UserGuide_EN 

11 

Technical Support 

If you register your copy of Readiris you are entitled to free technical support. 

To access Technical Support: 

• Click the Help tab. 

• Click Product Support. 

 

From the Help menu you can also access Getting Started videos and a Knowledge Base, ask us a question, 

etc. 
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Section 2: Getting Started 

Using Readiris for the first time 

To run Readiris: 

• Double-click the Readiris icon on the Desktop. 

 

Or start Readiris from the Windows Programs list: 

• Click Start > All Programs > IRIS > Readiris. 

   



RI_17_UserGuide_EN 

13 

Exploring the interface 

The Readiris interface looks as follows: 

 

The interface consists of the following components and panels: 

1. Ribbon 

The Ribbon is by far the most important tool in Readiris. It contains all the commands you need to process 

your documents. The commands are classified per group. Groups, in turn, are collected under tabs. 

Tip: it is recommended to set the Language settings before scanning or opening documents. 

Tip: point the cursor to the different commands to display their tooltip. The tooltips describe what 

each command does. 

 

Note: should you want to autohide the ribbon, select the corresponding option in the View menu. 
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2. Pages panel 

Each page you scan or open in Readiris has its thumbnail displayed in the Pages panel. 

To change the order of the pages, drag a page from one location to another. You can also move pages up 

and down, or delete them by right-clicking them and selecting the corresponding action. 

The size of the thumbnails can be increased or decreased using the slider. This way the thumbnails can be 

displayed over more columns. 

To delete 

• all pages, click Delete All. 

• selected page(s), click Delete. 

 

3. Activity panel 

The Activity panel displays the tasks that Readiris is carrying out. In each field you see a description of the 

task, and on which page it is being carried out. 

Note: the more cores your computer is equipped with, the greater the processing speed will be. Note 

however that Readiris is limited to 4 threads, so more then 4 cores does not offer an advantage. 
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4. Scanned image 

When a document is scanned or opened into Readiris, its image is displayed. 

 

To view the analysis of the image into recognition zones, click the Zones tab. 

 

  

Note that the appearance of the components and panels described above can be customized to your liking. 
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Customizing the interface 

The interface can be customized in several ways: 

Autohiding the ribbon 

To autohide the ribbon, select the corresponding option in the View menu. 

  

Hiding panels 

In case you want to hide the panels completely: 

• Click the View menu. 

• Clear the Activity box if you want to hide the Activity panel. 

 

• Or click the cross on the panel to close it 

Moving the panels around 

The panels do not have fixed positions. They can be placed anywhere inside the Readiris interface. 

To move a panel: 

• Double-click its title bar. 

 

• The panel appears in a reduced version in the middle of the interface. 

• Now you can drag it to a different position, and expand it. 

 

• To restore a panel to its initial position, double-click its title bar again. 
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Note: to undo any changes you made 

• in the View tab, click the Reset button. 

• in all other settings, you can restore the factory settings. To do so, click the Readiris button in the 

top left corner, and then click Restore Factory Settings. 
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Changing the user interface language 

Readiris opens in the installation language by default. If you want to change the interface language: 

• Click the Readiris button in the top left corner or go to the tab Settings, then click User Interface 

Language. 

 

• In the Language window that opens, select the language of your choice, then click OK. 

 

  

Note: If you selected an incorrect language by mistake, click Ctrl+U inside Readiris. The Language dialog 

box opens and you can select another language from the list. 
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Configuring your scanner 

In order to scan documents in Readiris, your scanner must be configured correctly: 

1. Make sure your scanner is connected to your computer, and switched on. 

Note: the scanner should be physically connected to your computer with a USB cable. An Ethernet or 

wireless connection may also be used if the Twain driver supplied by the manufacturer has been 

engineered with that capability. 

2. Make sure you have the latest available Twain driver installed for your scanner. 

In general, drivers can be found on the website of your scanner manufacturer. They are not provided 

by I.R.I.S. Note that some scanner drivers may not work under the latest versions of Windows. See 

the documentation supplied with your scanner to find out which platforms are supported. If 

necessary, contact your scanner manufacturer. 

  

Scanner configuration in Readiris 

Readiris will try to detect automatically an installed scanner, its driver and will do an automatic 

configuration of any other needed settings such as resolution, paper format, etc. 

The automatic scanner detection is currently possible for an installed I.R.I.S., Canon, and HP device. 

For any other device, you have to do a manual configuration. 

  

Automatic scanner detection 

• This feature is activated when you click the Scan button 

o the first time you use an installed scanner 

or 

o after a Restore Factory Settings operation 

 

• A Scanner detection message is displayed. 

o To confirm the automatic detection action, click OK. 
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• When clicking OK, Readiris starts the matching process. It tries to match the installed scanner with 

a scanner model or profile of the list of validated scanners in Readiris. 

For the time being, this list consists mainly of Canon, HP and IRIS devices. 

• If Readiris detects a match, it proposes the corresponding scanner profile in the Scanner 

modelwindow. 

  

In this example, a Canon MF416dw MFP device is configured and Readiris proposes Canon MF410 series 

 

• To confirm the proposed device as the current model to be used in Readiris, click OK. 

If Readiris cannot find your scanner model, go to the Manual scanner detection section. 

• Readiris will, then, load the corresponding TWAIN driver installed on the system, and display the 

Scanner setting window pre-filled with the scanner capabilities, such as resolution, paper format, 

etc. 

 

• To start scanning, click OK. 
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For more information about the different scanner settings, see the topic Selecting the Scanner Settings. 

 

Manual scanner detection 

• If Readiris cannot find automatically your scanner model, select it manually in the Scanner model 

list. 

In this list you select your scanner profile. The scanner profile allows you to access features specific 

to your scanner. For example, duplex scanning. 

Do not worry if you don't see your scanner in the list; not all scanners have specific scanner profiles. 

Important note: in case you don't find the exact same profile, do not select a profile that 

resembles it. Instead, select a universal Twain profile. Different Twain profiles are available: 

Select <Twain><OTHER MODELS> when you are using a regular, flatbed scanner. 

Select <Twain><OTHER MODELS>(User interface) if you want to use your scanner user 

interface to scan documents. 

Select <Twain><OTHER MODELS with duplex feeder> when you are using a duplex 

scanner, which scans both the front and backside of a page. 

 

• Once you have selected a scanner model, you must configure you scanner driver. 

o Click Configure to select your scanner driver. 

If you do not see your scanner listed in the Select Source window, then your scanner driver 

has not been installed properly. Re-install your scanner driver before trying to configure it in 

Readiris. The scanner driver can usually be found on the website of your scanner manufacturer. 

 

 

Note: you can also configure the scanner driver directly on the main toolbar. Just click the 

down arrow beneath Scan and click Select Source. 

• Once the scanner has been configured you can start scanning, using the default scanner settings. 

For more information about the different scanner settings and how to change them, see the topic 

Selecting the Scanner Settings. 
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Section 3: Basic Document Processing 

Basic Document Processing 

Processing documents with Readiris is fairly straightforward when using a basic configuration. In this topic 

we discuss which steps to take when doing such a basic configuration. For detailed information about all the 

configuration steps, see sections 4 to 9. 

Before you begin: 

Select a Document Language from the drop-down menu in the Acquire group. 

Selecting the right document language is essential to obtain good recognition results with Readiris. 

The default language is set to the language you selected during installation. 

Note: you can always change the document language after opening a document, but know that 

Readiris then has to redo the recognition on the entire document. This of course slows down your 

process. 

 

Processing documents 

Step 1: Scan or Open your documents 

• Click Scan to scan paper documents with your scanner. 

In order to scan documents your scanner must be correctly configured. See the section Configuring 

your scanner if necessary. 

or 

• Click From File to open existing image files. 

 

The images are displayed in the interface. If necessary you can modify the recognition zones, and also the 

recognized text. See the section Editing the Recognized Documents for detailed information. 

  

Step 2: Select the Output Format and the Destination 

• Select one of your favorite output formats from the Output File group. 
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• The 3 output formats you used most recently are displayed in the Output File group. 

 

For detailed information about the different output formats and the different formatting options, see 

the sections Saving Documents and Selecting the Formatting Options. 

• To select a different output format, click Other. 

• To modify the settings of the selected format, click the down arrow beneath it, and then click its 

settings. 

 

Note that the first time you click an output format button, you are prompted to confirm or change the 

output settings. 
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Select the Destination 

• Select one of your favorite destinations from the Output File group. Click the down arrow, and then 

click settings 

 

  

• The 3 destinations you used most recently are displayed in this group. 

•  

• Select Save as File to save the documents locally to your computer or portable storage 

device. 

• Select E-mail to send the documents by e-mail. 

• Or select a Cloud application to send your documents to the Cloud. 

Note that the connection to the Cloud applications must be configured correctly to be able to 

export. See the section Sending Documents to the Cloud to learn how to do so. 

• To modify the settings of the selected destination, click the down arrow beneath it, and then click its 

settings. 

Note that the first time you click an output format button, you are prompted to confirm or change the 

output settings. 

 

When you have gone through these steps, Readiris starts processing documents. 

  

Tip: In case you want more guidance while configuring Readiris, use the Wizard. The Wizard guides you 

through each step of the configuration. See the section Using the Wizard for more information about each 

step. 

Saving the processing settings 

Note that Readiris saves the processing settings automatically when closing the application. Next time you 

start Readiris it applies the same settings. 

In case you want to save a specific settings profile: 

• Click the Readiris button or the tab Settings. 

• Then click Save Settings and name the settings file. 
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Loading settings 

• Click the Readiris button or the tab Settings 

• Then click Load Settings and select the settings file you saved. 

Restoring factory settings 

• Click the Readiris button or the tab Settings 

• Then click Restore Factory Settings. 
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Using the Wizard 

The Wizard guides you step by step through the configuration process. Once you have gone through the 

steps, click Go to start the automatic Readiris process. 

To start the Wizard: 

• Click the Readiris button or the tab Settings, then click OCR Wizard. 

 

Steps of the Wizard 

Step 1: Select the image source. 

You can use your scanner to scan documents, or open image files you already have on your 

computer. 

During this first step you can also apply rotation options. 

Select Page Deskewing if your documents are scanned crooked and you want to straighten them. 

Figure Step 1 

 

 

Step 2: Select your scanner 

(Note: if you selected image files in the previous step, proceed to Step 3). 

If you have already configured your scanner, your scanner model is displayed here. If it is not, see 

Configuring your scanner and Selecting the Scanner Settings. 

Figure Step 2 
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Step 3: Select the Document Language of your documents. 

The default document language is set to the language you selected during installation. Click Change 

to select a different language. 

Note: selecting the correct language is extremely important in order to obtain good recognition 

results. 

Figure Step 3 

 

 

Step 4: Select the Output Format and (Cloud) Destination. 

Your documents are saved as .docx files by default. Click Change to select a different output format 

or destination application. 

For more information about the different output formats and their options, see the section Saving 

Documents and Selecting the Formatting Options. 

Figure Step 4 

 

When you are done selecting the settings, click Next and then click Go to start processing documents. 
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Section 4: Selecting the Recognition Options 

Recognition Options 

Readiris converts Microsoft Office documents, scanned images, image files and PDF files into editable text 

documents and text-searchable PDF documents. In order for Readiris to recognize the text in your images, 

you need to activate the correct recognition options. 

Tip: it is recommended to set the document recognition options before you scan or open any 

documents in Readiris. The reason for this is that Readiris carries out the document recognition 

simultaneously while opening or scanning multiple pages. 

The recognition options are located in the Acquire group. 

 

Below you find an overview of the different options. 

Document Language 

The Document Language is by far the most important recognition option. The quality of the document 

recognition depends a great deal on selecting the correct recognition language. The recognition language is 

set to the language you selected during installation. 

To select a different language: 

• Click the down arrow right of the Document Language list and select the language of your choice. 

 

  

Other Recognition Options (Readiris Pro + Corporate) 

Page Analysis 

By default, Readiris executes the text recognition of your pages. However, the recognition can be turned off 

on demand by unchecking the Page Analysis box. Simply turn the recognition on again by checking the 

same box.  

 

Note: when the automatic recognition is turned off, you can still define the zones manually or load a 

previously saved template.  
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Recognizing numeric documents 

When you are processing documents that only contain numbers and almost or no text, then it is 

recommended to select the Numeric option. 

When this option is selected Readiris only recognizes the numerals 0-9 and the following series of symbols: 

+ 

plus 

sign 

* 

asterisk 

/ 

slash 

% 

percentage 

sign 

, 

comma 

. 

period 

( 

opening 

parenthesis 

) 

closing 

parenthesis 

- 

hyphen 

= 

equation 

sign 

$ 

dollar 

sign 

£ 

pound sign 

€ 

euro sign 

¥ 

yen sign 

  

To select the Numeric option: 

• Click the expansion arrow on the Acquire group to open the Advanced Settings. 

 

• Click the Language tab and then, check the Numeric box. 

 

Recognizing Western words in Cyrillic and Slavic languages and in Greek 

When you are processing Cyrillic, Slavic or Greek documents that also contain "Western" words written in 

the Latin alphabet - such as proper nouns, then it is recommended to select one of the available Language 

pairs. 

Language pairs are always combined with the English language and are available for Russian, Byelorussian, 

Ukrainian, Serbian, Macedonian, Bulgarian and Greek. 

To select a Language pair: 

• Click the down arrow right of the Document Language list. 

• Then select the required language pair. 

Example 
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Speed vs. Accuracy(Readiris Corporate only) 

In Readiris you can choose whether to favor recognition speed over accuracy and the other way around. 

Tip: when you are processing low-quality images, it is recommended to set this feature to 

accuracy. This yields markedly better results. 

To access the Speed vs. Accuracy option: 

• Click the expansion arrow on the Acquire group to open the Advanced Settings. 

 

• Click the Language tab. 

• Move the slider to Speed for faster processing. 

• Or move the slider to Accuracy for better recognition results. 

 

  

Other Recognition Options (Readiris Corporate only) 

Recognizing Secondary Languages inside a single document 

When your documents contain text in multiple languages, it is recommended to select a main recognition 

language, combined with several Secondary languages. You may select up to 4 secondary languages: 

• Click the expansion arrow on the Acquire group to open the Advanced Settings. 

• Click the Language tab. 

• Check the boxes of the required languages of the Secondary languages list . 

• Secondary languages that are unavailable for the selected main language are grayed out. 
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Recognizing Arabic Documents 

When recognizing Arabic documents in Readiris Corporate, you can choose which recognition engine to use: 

omnifont or multifont. 

By default, Readiris uses the omnifont engine, which recognizes all fonts. To obtain the best recognition 

results it is recommended to use the multifont engine. This way, you can select the fonts used in your 

documents. 

• Click the expansion arrow on the Acquire group. 

• Then select Arabic from the main language list. The Fonts button now becomes available. 

 

• Click the Fonts button, then select Use multifont engine. 

 

• Select the fonts you want to recognize in the left column, and move them to the right column by 

clicking the right arrow. 

 

Note: when the multifont engine is selected, Readiris actually uses both the onmifont and the multifont 

engine to do the recognition and then uses a voting mechanism to choose the best result. To favor the 

multifont engine, move the slider to the right. Note that when you move the slider to zero, the multifont 

engine will not be used. 

Tip: should the recognition results be unsatisfactory, even though you selected the correct recognition 

options, then the image quality of your documents is probably insufficient. See the section Adjusting the 

Image Quality to solve this problem. 
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Advanced Recognition Options 

Next to the document language, you can also configure other, advanced options that play an important role 

in the processing of documents, such as the Font type and Character pitch for instance. 

To access the advanced recognition options: 

• Click Advanced Settings on the Acquire tab. 

 

Or 

• Click the Readiris button and click Advanced Settings. 

 

Or 

1. Click the tab Settings and click Advanced Settings. 
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Acquire options 

Before you scan or open any documents in Readiris you can set a number of Acquire options. These 

options help to improve the recognition results and are carried out during the scanning/opening of 

documents. 

Rotation options 

Readiris can rotate your documents 90° to the right, 180° and 90° to the left. 

When you are processing a bunch of documents that do not have the same orientation, select Automatic. 

In that case Readiris rotates the documents automatically in the right direction. 

 

Note: make sure your documents are facing the right direction - meaning the text is facing the scanning 

surface. Otherwise Readiris will not be able to rotate them. 

Page Deskewing 

Select this option when you need to straighten documents that were scanned crookedly. 

 

If the Acquire options you selected do not generate the results you were hoping for, you can change them 

manually after scanning/opening your documents. See Section 7: Editing the Recognized Documents to 

learn how to do so. 

Font type and Character pitch 

Font type 

Readiris distinguishes between "regular" and dot matrix printed documents. Dot matrix printers are printers 

that create documents with text made up of isolated, separate dots. 

Special segmentation and recognition techniques are required to recognize dot matrix documents and need 

to be activated. 

 

To select the font type: 

• Click the Readiris button, and then click Advanced Settings. 

• Click the tab Font type. 

• The font type is set to Automatic by default. 

That way, Readiris recognizes "24 pin" or "NLQ" (Near Letter Quality) dot matrix, or other "normal" 

printing. 

• To recognize only dot matrix printed documents, click Dot matrix. 

Readiris will recognize so-called "draft" or "9 pin" dot matrix printed documents. 
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Character pitch 

The character pitch is the number of characters per inch in a particular font. The character pitch can either 

be fixed, in which case all characters have the same width, or proportional, in which case the characters 

have a different width. 

To select the character pitch: 

• Click the Readiris button, and then click Advanced Settings. 

• Click the tab Font type. 

• The character pitch is set to Automatic by default. 

• Click Fixed if all characters of the font have the same width. This is often the case in old typewriter 

documents. 

• Click Proportional if the characters of the font have a different width. Virtually all fonts in 

newspapers, magazines and books are proportional. 

   

Important: these document characteristics do not apply to Asian, Hebrew or Arabic documents. 

Barcodes 

How to process barcodes is explained in the corresponding How to section: How to recognize barcodes. 

Document Processing 

The Document Processing options are explained in the corresponding How to section: How to separate 

document batches. 

Teaching options 

The Teaching options are explained in the section: Teaching Mode. 

Language options 

The Language options were already explained in the section Recognition Options. 
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Section 5: Scanning and Opening Documents 

Scanning Documents 

Before you begin: make sure your scanner is connected to your computer and configured correctly. If 

necessary, see the topic Configuring your scanner. 

  

Readiris is Twain compliant. It supports almost any flatbed and sheet-fed scanner, all-in-one device, digital 

camera and scanner currently available. 
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Selecting the Scanner Settings 

Scanner model 

Readiris proposes an automatic scanner detection. If your scanner model is not yet included in the list of 

the supported scanners for the automatic scanner detection, you have to perform a manual scanner 

configuration. 

To select manually your scanner model, click Scanner Model to select your scanner profile from the list. 

The scanner profile allows you to access features specific to your scanner. For example, automatic 

document feeder (ADF). Settings that are unavailable for your scanner are not displayed or grayed out. 

 

Do not worry if you don't see your scanner in the list; not all scanners have specific scanner profiles. 

If you do not find your exact scanner in the list, do not select a similar profile. Instead, select a universal 

Twain profile. Different Twain profiles are available: 

Select <Twain><OTHER MODELS> when you are using a regular, flatbed scanner. 

Select <Twain><OTHER MODELS>(User interface) if you want to use your scanner user 

interface to scan documents. 

Select <Twain><OTHER MODELS with duplex feeder> when you are using a duplex scanner, 

which scans both the front and backside of a page. 

 

Configure 

Click Configure to select your scanner driver. Selecting the correct scanner driver is required for Readiris 

to be able to communicate with the scanner. 

If you do not see your scanner listed in the Select Source window, then your scanner driver has not been 

installed properly. Re-install your scanner driver before trying to configure it in Readiris. The scanner driver 

can usually be found on the website of your scanner manufacturer. 
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Note: you can also configure the scanner driver directly on the main toolbar. Just click the down arrow 

beneath Scan and click Select Source. 

Contrast 

When scanning low-quality documents, adjusting the Contrast level is sometimes required to obtain an 

optimal scan result. 

Move the Contrast slider to the right to increase the contrast between the background and the text. Move 

it to the left to reduce the contrast. 

Note: when the option Auto-exposure is selected, the Contrast slider is unavailable. The contrast 

settings are then adjusted automatically. 

Brightness 

When you are scanning dark, blurry images, or extremely light images, it may be necessary to adjust the 

Brightness settings. 

Move the Brightness slider to the right to increase the brightness of your scans. Move the slider to the left 

to reduce the brightness. 

Note: when the option Auto-exposure is selected, the Brightness slider is unavailable. The 

brightness settings are then adjusted automatically. 

Optimize resolution for OCR 

This option adjusts the resolution of images that were scanned with too much detail (over 600 dpi). When 

this option is activated Readiris reduces the resolution to a suitable level. 

Note that this option doesn't increase the resolution of images scanned with too little detail. 

Scan another page after 

This option is useful when you are scanning multiple pages on a flatbed scanner. It allows you to determine 

after how many seconds Readiris scans another page. This way, you have the time to change the pages on 

the scanner while Readiris scans them automatically. You no longer need to go back to your Readiris 

application and click the Scan button every time you want to scan a new page. 

Use the up and down arrows to determine after how many seconds you want Readiris to scan a new page. 

Format 

Click the Format list to define the size of the documents you are scanning. 

Tip: in the US Letter and Legal are the two most common formats. Internationally, A4 is the 

standard. 

Resolution 

Select in which resolution you want to scan images. A resolution of 300 dpi (dots per inch) is 

recommended. When you are scanning very small print or Asian languages, 400 dpi is recommended. 

Color mode 

Readiris can scan documents in color, black-and-white and grayscale. 

Note that grayscale and color images return the best OCR results. 
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Landscape 

Select the Landscape option when scanning landscape-oriented documents instead of portrait-oriented 

documents. 

When this option is selected, Readiris displays your documents as landscape-oriented documents in the 

interface. 

   

Auto-exposure 

With some scanners the Auto-exposure option is selected by default. This option adjusts the contrast and 

brightness settings automatically. A good contrast is required to obtain optimal recognition results. 

Note: when this option is selected, the Contrast and Brightness sliders are unavailable. 

ADF 

ADF stands for Automatic Document Feeder. This option is available when your scanner is equipped with an 

automatic document feeder. Select this option when you want to scan stacks of documents all at once. 

Invert 

Sometimes Twain scanners display white text on a black background when scanning documents in black-

and-white. To reverse the color of text/background on your documents, select the Invert option. 

Digital camera 

When you are using a Twain compatible digital camera, you can use your camera directly as scan 

source. To do so, select the Digital camera option. Readiris will then use special recognition routines to 

process the digital camera images. 

See the section How to process digital camera images for tips on using a camera as scan source. 

Process as 300 dpi 

Select the option Process as 300 dpi when you are processing images of an incorrect or unknown 

resolution. The images will be processed as if they had a 300 dpi resolution. 

Smoothen color images 

This option is selected by default. It improves the appearance of color and grayscale images in your 

documents. 

Note: with some scanners, image smoothening is required to recognize color and grayscale images 

successfully. 

Duplex 

When using a duplex scanner - a scanner that can scan both the front and the back side of documents - the 

Duplex scanning option is available. Select this option to have Readiris scan the front and back side of 

documents. 

Fast Binarization (Readiris Corporate only) 

When you are using a high-speed scanner it is recommended to activate Fast Binarization. This option 

increases the processing speed considerably. 

Tip: avoid selecting this option when scanning very low-quality documents.  
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Scanning batches of documents 

(This section applies to Readiris Corporate only) 

If you need to scan entire batches of documents you can use Readiris' Watched Folder feature. 

This way, you can scan all your documents to specific folders that are being monitored by Readiris. 

Whenever Readiris spots a new document inside one of the Watched Folders, it processes it and exports it 

to a destination of your choice: in an output folder, in the Cloud or on an FTP server. 

Readiris supports up to 63 Watched Folders. Each watched folder can have a specific configuration. One 

watched folder configuration can for instance generate Compressed PDF documents and export them to 

Therefore. Another can generate RTF documents and export them to Google Drive, where they can be 

edited. While yet another one can also send documents to a different  instance of Google Drive, using 

different credentials (user name and password) and settings (output folder, etc.). 

  

Important notes: 

• When using a Readiris Watched Folder, it is not possible to use Readiris as scanning application at 

the same time. 

• When you already have documents open in Readiris, the Watched Folder option is unavailable. 

Either process or delete the documents to access the Watched Folder option. 

  

To set up a Watched Folder configuration: 

• Click the down arrow beneath the From File button. 

• Then click Watched Folder. 

Note that the Watched Folder option is only available when no documents are opened in Readiris. 

 

In the Watched Folder window, you need to define the following settings: 

• Set up a new watched configuration. 

• Click the corresponding button. 
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• In the Window Folder 1. : Select image file, browse for the input folder to 

which you will scan the documents. 

• Click OK to confirm. 

  

If you want to change the input folder, click Select image folder. 

 

• Select the output text folder (Skip this step if you want to save your output files in the 

Cloud). 

• Click the corresponding button to save your files on your computer 

 

• In the Window Folder 1. : Select Output text folder, browse for the output 

folder which must be different from the input folder. 

• Click OK to confirm. 

• Select the output format settings. 

• Click the corresponding button to define the output format and destination. 

 

• In the Output - Watched Folder 1., Select the output format, destination and 

lay-outing options. For more information see Saving Documents and Sending 

Documents to the Cloud. 

• Click OK to confirm. 
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Tips: 

o If you want Readiris to process the subfolders of a Watched Folder, then select 

Process subfolders. 

Note: when the Process subfolders feature is activated, it is not possible to use a 

subfolder of an existing watched folder as watched folder in a new watched folder 

configuration. 

Example: in Configuration 1 you select Process subfolders and you use C:\Input as 

Watched Folder. C:\Input has a subfolder called Batch1. In that case C:\Input\Batch1 

cannot be used as Watched Folder in Configuration 2. 

o When using multiple Watched Folders, it is very useful to use the feature Add time 

stamp to filename. 

This way, you avoid generating output files that have the same file name, which would be 

overwritten when using the same output destination. A time stamp looks as follows 

<filename>_YYYYMMDDHHMMSS and contains the year, month, date, hour, minutes and 

seconds of the creation time. 

• When you are done, click OK to start monitoring the Watched Folder. Or click New watched 

configuration to configure another Watched Folder. 

  

During monitoring, Readiris processes any images it spots inside the folder. 

Tip: click Minimize to have Readiris run in the background. 

 

To add documents to the Watched Folder while it is being monitored by Readiris: 

• Scan documents using your scanner's interface, or 

• Move existing image files to the Watched Folder. 
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Opening Image Files 

Besides scanning documents, you can also open image files and PDF files with Readiris. 

Readiris supports the following image file and document file formats. 

Image file format and document file format File extension 

Adobe PDF *.pdf 

JPEG images *.jpg, *.jpeg 

JPEG 2000 images *.j2c, *.j2k, *.jp2 

Microsoft Word documents *doc(x) 

Microsoft Excel worksheets *xls(x) 

Microsoft PowerPoint presentations *ppt(x) 

Rich Text Format documents *rtf 

Portable Network Graphics *.png 

(Compressed and multipage) TIFF images 

uncompressed and LZW, PackBits, Group 3, Group 4 and JPEG compressed 

*.tif, *.tiff 

Windows bitmap *.bmp 

ZSoft Paintbrush images *.pcx 

To open existing image files: 

• Click the From File button. 

 

• Then select the images files you want to process, and click Open. 

  

Note: If your image file has been scanned in a low or unknown resolution, Readiris displays the following 

warning: 

 

Click Open anyway to continue with your image.  

Tip: click the Help button for pointers on how to obtain the best possible results with low-resolution 

images. 
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Opening options 

When opening image files, several options are available: 

Digital camera 

Select this option to open digital camera images. Then, in the Home view, click the 3D Correction tool to 

optimize them. 

Smoothen color images 

This option is selected by default. It improves the appearance of color and grayscale images in your 

documents. 

Note: with some scanners, image smoothening is required to recognize color and grayscale images 

successfully. 

Process as 300 dpi 

Select Process as 300 dpi when you are processing images of an incorrect or unknown resolution. The 

images will be processed as if they had a 300 dpi resolution. 

Fast Binarization (Readiris Corporate) 

When you are opening many image files at the same time, it is recommended to activate Fast 

Binarization. This option increases the processing speed considerably. 

Tip: avoid selecting this option when scanning very low-quality documents. 

Page range 

Use this option when you only want to open a certain section of multipage TIFF or PDF files. 

Select All pages to open the entire document. 

Or select Pages and indicate the page range. 

Other ways of opening image files 

Besides the From File button you can also open image files by dragging them to the Readiris interface. 
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Processing Batches of Image Files 

(This section applies to Readiris Corporate only) 

When you are processing entire batches of image files, you can use Readiris' Batch OCR option. 

• Click the down arrow beneath the From File button. 

 

• Then click Batch OCR. 

Note that the Batch OCR option is only available when no documents are opened in Readiris. 

• Browse for the input folder, where your image files are located. 

• Click the Select the output format button to select the required output format, the formatting 

options and the destination. 

Tip: see the topics Saving Documents and Selecting the Formatting Options for more information. 

• Then, browse for the output folder, where your processed documents will be stored. 

Skip this step if you want to send your processed files to the Cloud. 

 

• Then select the processing options: 

o Process subfolders processes any underlying folders of the input folder. 

o Overwrite output text files overwrites any existing output files with the same name in the 

output folder. 

o Delete scans after recognition deletes your original input images once they have been 

processed. 

o Add time stamp to filename add the date and time to the filename of your document. 

This way, you avoid generating output files that have the same file name, which would be 

overwritten when using the same output destination. A time stamp looks as follows 

<filename>_YYYYMMDDHHMMSS and contains the year, month, date, hour, minutes and 

seconds of the creation time. 

• When you are done selecting the options, click OK to start processing documents.  
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Teaching Mode 

To improve the recognition results, you can use Readiris' Teaching Mode. By means of teaching you can 

train the recognition system on fonts and character shapes, and correct the OCR results if necessary. 

During the teaching process, any characters the recognition system is not sure of are displayed in a 

preview window, in combination with the word in which they were spotted and the result suggested by 

Readiris. 

 

1 A character Readiris is not sure of. 

2 The word in which the character was spotted. 

3 The solution how Readiris suggests to recognize it. 

Teaching can substantially enhance the accuracy of the recognition system and is particularly useful when 

recognizing distorted, defaced forms. Teaching can also be used to train Readiris on special symbols it is 

unable to recognize initially, such as mathematical and scientific symbols and dingbats. 

ATTENTION: teaching occurs during recognition. The teaching results are temporarily stored in the 

computer memory for the duration of the recognition. Readiris will no longer display the trained characters 

when OCRing the rest of the document. When a new document is OCRed, the teaching results are erased. 

To save teaching results permanently, use the Teaching Mode in combination with a font dictionary. 

Tip: in case the recognition results still need to be edited afterwards, you can use the Text Corrector. 

See the topic Editing the Recognized Documents for more information. 

Accessing the Teaching Options 

• Click Advanced Settings on the Settings tab 

• Or click the expansion arrow in the Acquire group from the Home tab 

• Click the Teaching mode tab. 

• Check the Teaching Mode box. 
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Font Dictionaries 

As stated above, it is recommended to use the Teaching Mode combined with a Font Dictionary, in order to 

store the teaching results permanently. 

When you are using the Teaching Mode for the first time and you have not created a Font Dictionary yet, 

select New Font Dictionary. Now enter a name for the dictionary in the window that opens, and click 

Open. 

Note: Do not modify the .DUS extension of the dictionary. 

Note: Font Dictionaries are limited to 500 shapes. You are recommended to create separate 

dictionaries for specific applications. 

 

To use an existing Font Dictionary afterwards, either select Append Font Dictionary or Read Font 

Dictionary. 

When you select Append Font Dictionary, make sure to enable the Teaching Mode. In this mode Readiris 

recognizes the characters shapes stored in the dictionary and adds the new teaching results. 

When you select Read Font Dictionary, Readiris only recognizes the character shapes stored in the 

dictionary but does not add the new teaching results, even if the Teaching Mode is enabled. Note however 

that it can still be useful to use the Teaching Mode to check, and if necessary, correct the recognition 

results which are not saved in the font dictionary. 

Caution: make sure you do not open an existing dictionary while the dictionary mode is set to New 

Dictionary. This will erase the contents of the existing dictionary and create a new one using the same 

name. 

Using the Teaching Mode 

• When you are done configuring the Teaching and Font Dictionary options, open or scan your 

documents. 

• At the end of the recognition, Readiris enters the Teaching Mode. 

The characters the recognition system is not sure of are displayed. 
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If the results are correct: 

o Click the Learn button to save the result as sure. 

If you are not using a Font Dictionary, the teaching results are temporarily stored in the 

computer memory, for the duration of the recognition. When you scan a new document, you 

will have to go through the same steps again. 

If you are using the New Font Dictionary option or Append Font Dictionary option, the 

results are saved in the dictionary and you won't have to go through the same steps again. 

o Click Finish to save all solutions the software offers. 

If the results are incorrect: 

o Type in the correct characters and click the Learn button. 

or 

o Click Don't learn to save the result as unsure. 

Use this command for damaged characters which could be confused with other characters if 

trained. For example, the number 1 and the letter I have an identical form in many fonts. 

o Click Delete to delete characters from the output. 

Use this button to prevent document noise from appearing in the output file. 

o Click Undo to correct mistakes. 

Readiris keeps track of the last 32 operations. 

o Click Abort to abort the training. 

All training results will be deleted. Next time you open or scan a document, the Teaching 

Mode will start again. 
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Section 6: Adjusting the Image Quality 

The recognition results depend a great deal on the image quality of your documents. If you are scanning 

very low-quality documents, Readiris will not be able to recognize them properly. 

The reason for this is that Readiris works by converting pictures of text characters into actual text 

characters. If your documents are too dark, the characters fade into one another and create black spots. 

If your documents are too light, the text characters might be broken. Consequently, Readiris will not be 

able to recognize them. 

Example 1: text is too dark 

Here, the letter shapes begin to fill in and become fuzzy. Letters like a, e, and o are almost completely 

blurred. 

 

Example 2: text is too bright 

Here, the text characters start to show gaps and incomplete shapes. 

 

To improve the recognition results: 

• First make sure your documents have been scanned in a resolution of at least 300 dpi. If that's not 

the case, re-scan your documents using a proper resolution. 

See the section Selecting the Scanner Settings if necessary. 

• Click Adjust in the Home tab. 

(The same command is also available on the Page tab). 
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Adjust Image tab 

 

Smoothen color image 

This option is selected by default. It smoothens out differences in intensity, creating a greater contrast 

between the text and the background. Sometimes smoothening is the only way to separate text from a 

colored background. 

  

Dither Remove 

For image files containing text in colored background and scanned in black and white, there is dithering 

(i.e. black and white spots) in the scanned black and white file, that influences the OCR quality.   

Due to the fact that during the dithering process a part of the image information is lost, the resulting image 

after the dithering removal will not be the same as the original. However, the resulting image would 

improve the OCR quality. 

This tool can be used only on black & white images. 

  

Fast Binarization (Readiris Corporate) 

When you selected Fast Binarization in the From File options or in the Scanner Settings, the same option 

is selected in the Adjust Image menu. This option is useful when scanning or opening many image files at 

the same time, as it increases the processing speed considerably. 
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When this option is selected, you cannot manually adjust the Brightness and Contrast options however. 

Clear this option to be able to adjust them manually. 

Brightness 

Move the slider to increase or decrease the brightness of your documents. 

Example 1: image is too dark 

The image below is too dark and results in a plain black image. There is no text to be recognized. 

   

In this case you need to brighten the image in order for the text to be displayed. 

 

Example 2: image is too bright 

The image below is too light and results in broken text characters. The text is hardy legible. 

   

In this case you need to darken the image to obtain satisfactory results. 

 

Contrast 

Move the slider to increase or decrease the contrast between the text and the background. 

Example 

The image below results in broken text characters. 

 

In this case you need to increase the contrast to obtain satisfactory results. 

 

Despeckle 

Sometimes documents contain a lot of "noise" - little black spots that occur when scanning low-quality 

documents or using bad scanner settings. 

To remove these little black spots, use the Despeckle slider. The more you move it to the right, the larger 

the spots that will be removed. 
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When you are done adjusting the image quality: 

• Click Apply to preview the results. 

• If the results are satisfactory, click OK. If not, change the settings again. 

  

Ignore Lines tab 

 

You can use this option to remove vertical, horizontal or both types of lines from scanned black and white 

images in order to improve the page analysis and facilitate the OCR . 

Minimum length: minimum length of the lines to remove. 

Maximum thickness: maximum thickness of the lines to remove. 

Maximum gap: maximum line gap to close (in case of broken, interrupted lines). 

  

Please note that this tool doesn't actually remove the lines from the output files. 
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Section 7: Editing the Recognized Documents 

The recognized documents can be edited in several ways in Readiris. Not only can you rotate and deskew 

the scanned pages, and edit their recognition zones, but you can also edit the recognized text in the Text 

Corrector. 

See the following sections for more information:  

  

Modifying the Page Options 

Editing the Recognition Zones 

Using Zoning Templates 

Using the Text Corrector 
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Modifying the Page Options 

• In the Pages panel, select the page that needs to be changed. 

 

• Then click the Page tab in the main toolbar. 

 

Organize 

Use the arrows in the Organize group to switch to other pages. 

Tools 

• Click Delete Blank Pages to delete any blank pages you have currently scanned / opened in 

Readiris. 

Note: this option in not available if there are no blank pages among your documents. 

Move the slider to determine which pages must be considered blank. The more you move the slider 

to 'high', the faster a page will be considered as blank. 

• Click Include All Pages to include all pages in the output file. 

• Click Exclude All Pages to exclude al pages from the output file. 

Image Tools 

Deskew 

Click Deskew to straighten a page that was scanned crookedly. 
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3D Correction 

Click 3D correction to apply perspective correction on an image. 

Note: obtaining the right perspective correction is essential to produce good recognition results. Readiris 

automatically searches for the page borders or text alignments to determine which perspective correction 

to apply. 

 

Rotate 

Click the down arrow and select how to rotate the page: left, right or upside down. 

Adjust 

The Adjust options allow you to adjust the image quality. See Section 6: Adjusting the Image Quality for 

more information. 

Print 

This command prints the selected page. 

Save as Image 

On the Page tab you can also save your pages as images. This is explained in the section Saving 

Documents as Image Files. 

  

Tip: If you want to modify the recognition zones, click the Zones tab. See the topic Editing the 

Recognition Zones for more information. 
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Editing the Recognition Zones 

Introduction 

When you scan a document or open an image file in Readiris, each page is divided into recognition zones. 

To have them displayed, go to the Zones tab. Readiris uses these zones to determine how each part of 

your documents must be converted. If your document does not contain any zones, it cannot be recognized. 

In Readiris Pro there are 3 kinds of recognition zones. You have text zones, image zones and table 

zones. In Readiris Corporate you can also have a fourth zone type, being barcode zones. 

Notice that each zone type has its own color. 

Text zones Orange 

Image zones Purple 

Table zones Pink 

*Barcode zones Green 

*Readiris Corporate only. 

The zones are also numbered; notice the number in the top left corner of each zone. The numbers run top-

down and from left to right*. They indicate the order in which the zones are recognized. 

*Note: when processing Arabic documents, the numbers run from right to left, if you select Arabic as 

main language. 

Example of recognition zones 

 

Modifying the automatic Page Analysis 

The zones we discussed above are created automatically when you click the Zones tab . Note however that 

this automatic page analysis is far from fixed. It can be modified in several ways. For instance, you can 

manually create new zones, change the zone of existing zones, expand and reduce zones in size, change 

the sort order, and so on. 

Note: if you want to do text editing, use the Text Corrector. 

To access the Editing and Layout options: 

• Scan or open a document in Readiris. 

• Click the Zones tab. 
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The Editing and Layout options 

Below you find an overview of the editing and layout options in Readiris. 

Note: when you make any modifications to the layout, Readiris redoes the recognition on the entire page. 

Manually drawing zones 

In case Readiris missed any recognition zones you can draw them manually. 

Note that barcode zones must always be drawn manually. 

To draw zones: 

• In the Editing group, click the zone type you want to create. 

 

• Then click and hold the left mouse button and draw a frame around the section you want to 

recognize. 

  

Changing the zone type 

When scanning bad quality documents, it may occur that Readiris does not determine the zone types 

correctly. If that happens, know that you can change the zone types manually: 

• Right-click the zone you want to change. 

• Point to Zone > Type, and then click the zone type of your choice. 

 

Important note: if you are processing bad quality images, Readiris will likely have problems recognizing 

them correctly. Refer to the section Adjusting the Image Quality to learn how you can avoid such issues. 

Changing the zone type of multiple zones simultaneously 

When scanning bad quality documents, it may occur that Readiris does not determine the zone types 

correctly. If that happens, know that you can change the zone types manually: 

• Click Select zone on the Editing group. 
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• Press and hold the Shift key while clicking the zones you want to modify. 

• Then, while still pressing the Shift key, right-click inside a selected zone, point to Zone > Type and 

click the zone type of your choice. 

Important note: if you are processing bad quality images, Readiris will likely have problems recognizing 

them correctly. Refer to the section Adjusting the Image Quality to learn how you can avoid such issues. 

Expanding or reducing zones 

• Click Select zone in the Editing group. 

 

• Then click inside the zone you want to reduce or expand. 

• Click and hold one of the bullets on the frame, then drag the frame in the desired direction to 

expand or reduce the zone. 

 

Changing the sort order of zones 

The order in which the zones are numbered determines in which order they will be included in the output 

documents. To change the order: 

• Click the Sort button in the Layout group. 

The numbers now disappear from the zones. 

 

• Now click the recognition zones one by one, in the order you want to sort them in. 

Moving zones 

• Click Select zone in the Editing group. 

 

• Then click inside the zone you want to move, hold the left mouse button, and drag the frame to the 

position of your choice. 

Connecting zones 

Suppose you have two text zones that belong together, and you want to turn them into one single text 

zone. In that case: 
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• Select Text in the Editing group. 

 

• Then draw a text zone between the two zones to connect them. 

        

 

• The two zones are merged into one. 

Note that only zones of the same zone type can be connected. 

Deleting zones 

In case you want to exclude zones from the recognition: 

• Click Select zone in the Editing group. 

• Then press and hold the shift key and select the zones you want to delete. 

• Right-click one of the selected zones, point to Zone and click Delete. 
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Deleting small zones 

Sometimes documents contain a lot of "noise" - little black spots that occur when scanning low-quality 

documents or using bad scanner settings. When that is the case, Readiris tends to mark them as 

recognition zones, even though they do not contain any useful content. 

To exclude these zones from recognition: 

• Click the option Delete small zones. 

• This option erases all windows smaller than 0.5" and re-sorts the remaining zones. 

 

Ignoring zones on borders 

When your scanner generates black borders around your documents, Readiris tends to mark them as 

recognition zones, even though they do not contain any useful content. 

In such cases it is recommended to use the option Do Not Detect Windows on borders. That way, the 

border zones will be excluded from the recognition. 

 

Ignoring a certain zone 

In case your document only contains content in a certain area of the page, you can use the Crop option to 

exclude the remainder of the page from the recognition. 

• Click Crop in the Layout group. 

• Then draw a frame around the section that contains the information. Everything outside the frame 

will be ignored. 

 

Note: you can also use this option to create Zoning templates, in case all your documents have a similar 

layout. See the section Using Zoning Templates. 
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Recognizing the content of a particular zone 

In case you only want to recognize the content of a particular text zone, and you don't need a fully 

converted output document, then you can use the Copy as Text option. 

• Right-click the text zone you want to recognize. 

• Then click Copy as Text. 

 

The results are copied to the clipboard as body text. You can now paste them into other applications. 
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Using Zoning templates 

When you want to scan many similar looking documents, it might be useful to apply zoning templates, 

instead of editing the recognition zones each time. In a zoning template you indicate what your documents 

look like and where the text, picture or tables zones are located. This way, Readiris only looks in the 

indicated areas, saving you a considerable amount of time. 

To create a zoning template: 

• Scan the first document. 

• Click the Zones tab to edit the zones to your liking. 

See Editing the Recognition Zones for more information. 

• Then click Save to save the zoning template. 

 

To use a zoning template: 

• Scan or open your documents in Readiris. 

• On the Zones tab, click Open Layout. 

• Select the layout file of your choice. 

• If you want to apply the layout to all the pages you have open in Readiris, select Apply layout to 

all pages. 

• Then click Open. 
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Using the Text Corrector 

The Text Corrector allows you to correct the recognition results. 

To access the Text Corrector: 

• Click Text Corrector in the main toolbar. 

Note: the Text Corrector command is only available if you have at least one document open 

in Readiris. 

 

How does the Text Corrector work? 

The Text Corrector displays the recognition results of the currently selected page. The original image is 

shown in the left-hand column and the recognized text in the right-hand column. The Text Corrector is 

displayed in Portrait view by default, meaning the columns are displayed side by side. 

To switch to Landscape view, where the columns are displayed on top of each other, select Landscape. 

 

Portrait view 
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The suspected words are marked in yellow in a red frame. 

To correct a word: 

• Click inside the recognized text column. 

• Type in the corrections. 

• Press delete on the keyboard to delete the unwanted results. 

• You can also delete entire words and paragraphs by selecting them with the mouse cursor and by 

pressing delete. 

• To undo editing actions, press Ctrl+Z on they keyboard. 

• To redo action you have undone, click Ctrl+Y. 

 

Note: images are not displayed in the recognition results, but will be included in the output 

files of course. 

Note: when you open a document that contains tables, a warning is displayed notifying you 

that tables are displayed as plain text in the recognition results, but will also included in the 

output files. The content of the tables is fully editable. 

Note: right-to-left languages such as Arabic and Hebrew are not supported in the Text 

Corrector. 

• To switch to the next suspect word, click the corresponding button or press F3 on the keyboard. 

 

• To move to different pages, click the forward or backward arrows. 

 

• To zoom in or out on the original image and/ or the recognition results, use the corresponding zoom 

commands. 

 

• To link the zoom levels of the original image and the recognized text and have a synchronized view, 

click the following button. 

 

• When you are done correcting the results, click OK to confirm. 

• To cancel all corrections you did, click Cancel and then select Yes to abort. 
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Section 8: Adding Annotations for PDF export 

Using Annotations 

The 'Annotate' Option allows you to add comments of various types on your document. 

  

Warning: 

Those annotations are supported and included into the final document when exporting to a PDF format 

only. Optimal results are rendered with the PDF viewer Acrobat Reader. Good results with any other PDF 

viewer are NOT guaranteed. 

  

To access the Annotation tool 

• Click the PDF tab in the Menu bar. 

 

• The Ribbon shows you the commands to add Annotations. 

• A PDF Annotation Panel appears on the right hand side of the screen. This panel lists and shows 

the annotations saved on the current page.  

 

To add an annotation on a page 

See individually the supported annotation types for an accurate description: 

• Text to speech 

• Watermark 

• Sticky note 

• Free text 

• Web link 

• Audio Record 

• File attachment 

• Highlight, underline or strikethrough Text 

• Stamp 
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When saved, all annotations are associated with a creation date and the username of their author. 

Depending on the annotation's type, those information can be shown on the output PDF document. It is the 

case for Sticky notes and Audio records.  

When a page is modified (rotation, text edition,...), the annotations are kept and repositioned or rotated if 

needed. 

  

To remove an annotation on a page 

Three possible ways.  

From the Annotation Panel, in the list: 

1. Right-click on the Annotation type you want to remove. A context menu opens. 

2. Select Delete 

 

OR, on the page: 

1. Right-click the icon. A context menu opens. 

2. Select Delete. 

OR, using the keyboard:  

1. Select the annotation icon on the page or in the annotations list 

2. Press Delete 

To edit an existing annotation on a page 

Three possible ways. 

From the Annotation Panel, in the list: 

1. Double-click the Annotation type you want to edit. The Edition window opens.  

OR 

1. Right-click the Annotation type you want to edit. A context menu opens. 

2. Select Edit.... 
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OR, on the page 

1. Double-click on the icon. The Edition window opens. 

To quit the Annotation tool 

• Leave the PDF tab. 

  

To export as PDF 

• Click on the PDF button in the ribbon. The Save as dialog box opens.  

For more PDF settings: 

1. Click the down arrow beneath the pdf button.  

2. Select PDF Settings. 

 

Warning: 

When selecting another format than PDF for export, a warning pop-up window is displayed: Annotations are 

not supported by other formats than PDF. 

The option 'In the future, do not show this message' can be selected. 
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Annotation types 

Text to Speech 

A text-to-speech (TTS) system converts normal language text into speech. By using this type of 

annotation, the text can be read out loud to you after the export as a PDF.  

  

To add Text-to-speech to your document: 

In the PDF tab: 

1. Click Text To Speech in the Ribbon. An edition box opens. 

2. Check Enable TTS. Click OK 

3. The Text-to-Speech engine does the conversion (cf. the Activity panel). To show that the annotation 

type is active, it appears in the PDF annotations panel and the icon of a loud speaker is displayed in 

the upper right corner of the pages.  

 

Default features: 

• The Text-to-speech is added to all the pages of the document. As an option, you can disable it from 

the PDF Export on the pages you have selected.  

o From the Pages Panel, select the pages concerned, right-click to open a Context menu, then 

select the option 'Disable TTS on this page'. 

o From the PDF Annotation Panel, right-click on the Text To Speech type, then select the option 

'Disable TTS on this page'. The annotation type is now grayed out.  

Follow the same paths to enable again TTS on the page. 
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Note: 

• The Text To Speech annotation is not reset when a new document is started. 

• If active, the Text To Speech annotation is also added to PDF documents created in batch, in 

watched folder mode or by conversion with the right mouse click in Windows Explorer. 

  

Voices and languages 

By default, Windows is using a 'voice' that comes with your Windows interface configuration 

(Settings/Time & Language/Region & language/languages). For more voices and/or languages, 

refer to the Windows Help.  
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Watermark 

The watermark annotation is a text drawn across a document’s page. 

  

To add a Watermark: 

In the PDF tab: 

1. Click Watermark in the Ribbon. An edition box opens. 

2. Check Enable Watermark 

3. Define and edit your watermark 

4. Click OK 

 

Edition options: 

• Text definition 

• Text orientation: horizontal or diagonal 

• Text color 

• Text opacity (from 0 to 100%) 

• Text size (from 0 to 100%) 

  

Default features of a Watermark: 

• The text is a single line 
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• The text is centered horizontally and vertically on the page 

• The text font style is predefined 

• The watermark is added to all the pages of the document. As an option, you can hide the 

watermark from the PDF Export on the pages you have selected.  

o From the Pages Panel, select the pages concerned, right-click to open a Context menu, then 

select the option 'Hide Watermark on this page'. 

o From the PDF Annotation Panel, right-click on the Watermark type, then select the option 

'Hide Watermark on this page'. The annotation type is now grayed out 

Follow the same paths to unhide the watermark on the page. 

 

 

  

To remove a Watermark: 

1. Open the edition dialog box by clicking Watermark in the Ribbon or by double-clicking on the 

watermark annotation in the annotation's list  

2. Uncheck Enable Watermark 

3. Click OK 

  

Note: 

• When exported into a PDF file, the watermark is permanent. It cannot be hidden when displayed 

or printed. 

• The watermark attributes are not reset when a new document is started and it is possible to set or 

edit them even if there is no page imported in Readiris. 

• The watermark is also added to documents created in batch, in watched folder mode or by 

conversion with the right mouse click in Windows Explorer. 
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Sticky Note 

The sticky note annotation is a note that can be positioned anywhere on the page. It appears as an icon 

and the text is attached to it. When you drag the mouse over the icon, the text content is shown as a 

tooltip. 

  

To add a Sticky Note: 

In the PDF tab: 

1. Click Sticky Note in the Ribbon.  

2. Click on the page where you want the icon of the note to be placed. An edition box opens. 

3. Select a sticky note type in the drop-down list. 

4. Select a color for the sticky note. 

5. Type your text in the text box. 

6. Click OK 

7. You can move the position of your sticky note when it is selected and the move cursor appears  

  

Edition options: 

• Icon Color  

• Various sticky note types: 

o Comment: with a speech bubble icon  

o Note: with an note symbol icon  

o Help: with a question mark icon  

o Key: with a key icon  

 

• Text Content: the text is edited in the text box and is shown in the Annotations panel.  

  

Note: The text color or text font of a Sticky note cannot be edited. It is not supported by the PDF format. 
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Free text 

The free text annotation is made of one or several text lines added on a document’s page. 

  

To add a Free text: 

In the PDF tab: 

1. Click Free text in the Ribbon.  

2. Click on the page where you want the free text to be displayed. An edition box opens. 

3. Type your text in the text box.  

4. Click OK 

5. On the page, you can adapt the box size when the resize icon shows up (width or height or 

both . Drag your mouse around the border of the text box). 

6. You can move the position of your free text when it is selected and the move cursor appears  

  

Edition options: 

• Text color (and callout line if selected) 

• Text Font size 

• Text alignment: left, center or right 

• Free Text as a Callout. When Callout line is selected, a small 'tail' is attached to the text box. The 

end point of that line can be dragged & dropped where you want on the page (thanks to the move 

cursor ). When the end point is moved, the start point location is updated automatically to 

prevent from the callout line to be drawn over the annotation text. 
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Default features of a Free text: 

• The text is drawn on a semi-transparent white background. That way it is easier to read without 

masking completely the content behind. 

• The content of the free text can still be re-defined in the PDF export.  
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Web Link 

The web link annotation allows you to include a URL anywhere on the page. 

  

To add a Web Link: 

In the PDF tab: 

1. Click Web Link in the Ribbon.  

2. Click on the page where you want the web link to be displayed. An edition box opens.  

3. Type the URL in the text box.  

4. Click OK 

5. You can move the position of the web link when it is selected and the move cursor appears  

  

Edition options: 

• Text and Border color  

 

  

Note: Only the web link box appears on the page, the text is invisible. When you drag the mouse over the 

box, the URL is shown as a tooltip. In the PDF export, the cursor turns into a hand icon to indicate there is 

a URL to click on.  
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Audio Record 

An audio record annotation is a short sound recording embedded in the file.   

  

To add an Audio record: 

In the PDF tab: 

1. Click Audio record in the Ribbon.  

2. Click on the page where you want the icon of the audio record to be placed. An edition box opens. 

3. Select a icon type in the drop-down list. 

4. Select a color for the icon. 

5. Record your audio annotation by using the recording buttons. 

6. Click OK. 

7. You can move the position of your audio comment when it is selected and the move cursor appears 

. 

  

Edition options: 

• Icon types: a loud speaker or a microphone  

• Icon color 

• Recording buttons: 

o Record: Click Record for the system to start the recording.  

o Stop: Click Stop to stop the recording or the playback. 

o Play: Click Play to play the recording. 

 

 

Default features of an Audio record: 

• Recording buttons are enabled only when relevant. 
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• The internal microphone (built-in) of your PC is used to register the audio records. Please refer to 

the Sound settings or Device Manager if you wish to change the device for sound input. The 

Windows help can provide you with more information. 

 

Sound Settings in Windows 10 

  

To play an Audio annotation in the PDF export (Acrobat Reader): 

1. Click on the loud speaker icon . The audio record is played on the default audio output of your 

device. 

  



RI_17_UserGuide_EN 

77 

File Attachment 

A File attachment annotation embeds a file at a selected location in your document, so that after the 

exportation as PDF, the reader can open it for viewing. By attaching files as a comment, you can reference 

longer documents that cannot easily be pasted into a sticky note or text box. To view an attachment, the 

reader must have an application installed that can open the attachment. 

  

To add a File Attachment: 

In the PDF tab: 

1. Click File Attachment in the Ribbon. 

2. Click on the page where you want the icon of an attached file to be displayed.  

3. The file browser window opens. Select the file to attach and click Open. 

4. The Edition window opens. Click OK. The annotation is created. 

5. You can move the position of the icon when it is selected and the move cursor appears  

  

Edition options: 

• Icon Color 

• Icon types: 

o Paper clip:  

o Pin:  

• Content/Comment: in some PDF viewers, this content or comment is shown when the mouse 

cursor runs over the icon. 
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Highlight, Underline or Strikethrough Text 

These text annotations consist in adding a graphical effect on existing text. 

  

To highlight, underline or strikethrough some existing Text: 

In the PDF tab: 

1. Select one of the three markups in the Ribbon.  

 

2. Create your highlight, underline or strikethrough text by selecting the text into the image view. 

3. The Annotation is created as soon as the selection is done 

  

Edition options: 

• Markup color 

• Content/Comment: in some PDF viewers, this comment is shown when the mouse cursor runs 

over the marked text. 

 

  

Note: For one same text selection, the type cannot be changed/edited after saving. It has to be removed 

and recreated. 
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Stamp 

You apply a stamp to an e-document in much the same way you apply a rubber stamp to a paper 

document. You can choose from a list of predefined stamps, or you can create your own stamps.  

  

To add a Stamp: 

In the PDF tab, go to the Stamp group: 

 

1. Select a Stamp from the list by clicking on the area showing the currently selected stamp. 

2. Click on the page where you want the stamp to be placed. 

3. You can move the position of your stamp when it is selected and the move cursor appears . 

4. You can adapt the Stamp size when the resize cursor shows up (width or height . Drag your 

mouse around the border of the stamp box). 

  

Edition options: 

In the Ribbon: 

• Stamp orientation: you can choose among a list of predefined orientations: horizontal, 30 degrees, 

45 degrees, 60 degrees or vertical 
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In the Configuration window: 

1. In the PDF tab, go to the Stamp group, click on Configure.... The Configuration window opens. 

 

Configuration Window for Stamps 

2. Select a stamp from the list on the left and choose your settings on the right: 

• First line of text: free text 

• Second line of text: free text. By default, some predefined stamps show the current date 

on the second line. The latter can be edited. 

TIP: to add the current date or current time to your stamp, you can type in those 

predefined variables: 

o $DATE: is replaced by the system date 

o $TIME: is replaced by the system time 

• Font size of second line: a slider controls the font size of the text on second line. 

• Stamp Color:  

• Border type: 4 possibilities 

o Rectangle 

o Rectangle with rounded corners 

o Arrow (to the left) 

Note: for the Arrow type, the color choice will affect the stamp background, the text 

color being selected automatically. 

o No border 
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Create a custom stamp or delete a stamp from the list: 

A custom stamp can be defined at any time from the Configuration window. 

1. In the Configuration window, click new at the bottom of the list to create a new custom stamp. 

Edit. 

2. Or, select an existing stamp and click remove to remove it from the list. 

  

Default features of a Stamp: 

• The stamps list is saved and remains available after Readiris is quit and restarted. The list is reset 

when Restore Factory Settings is invoked. 

• Editing or deleting a stamp in the predefined list does not affect the annotations of the same type 

already in use. 

• When a new stamp has been created, the font size of its second line and its border attributes are 

used as defaults for the next created stamp. 
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Section 9: Saving Documents 

The documents you process with Readiris can be saved in a large number of output formats, ranging from 

plain text files to fully formatted Word and Excel files, and also PDF and XPS files. 

With Readiris you can also turn Image PDFs - in which you cannot select or copy any text - into fully text-

searchable PDF documents. The same goes for Image XPS documents. 

To select an output format: 

• Click one of the popular output formats in the Output group on the Main toolbar. 

The 3 output formats you selected most recently are displayed. When you use Readiris for the first 

time, the 3 default output formats are .docx, .pdf and .txt. 

For more information about the available output formats, see the section Available Output Formats. 

• Click the down arrow beneath a format to configure its settings. 

 

• Select the file extension in the first drop-down list. 

 

• If you want the output file to be opened immediately after processing, select Open after saving. 

• The applications you have installed on your computer and that are capable of opening the 

selecting file format are displayed in the second drop-down list. 

• Select the application of your choice in the list. 

 

• In the third drop-down list you can select the destination. 

The output files are saved as files on your computer by default. 

You can also select a Cloud destination. For more information see Sending Documents to the Cloud. 
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• Select the formatting options on the tabs at the bottom of the screen. 

Note: only the settings that apply to the selected format are available. For more information see 

Selecting the Formatting Options. 

• Click OK to convert and save your documents. 

• When Readiris is done processing, the Output File window opens. Now name your output file. 

 

Note: Readiris, by default, saves all pages to a single output file. In case you want to generate a separate 

file for each scanned page, select Create one file per page. 

Please note that the option Create one file per document exists only in Readiris Corporate where we 

have the distinction between page  vs document (i.e. possibility to separate and save pages in different 

documents). 
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Note: once you have saved your documents, they are not automatically removed from the Readiris 

interface. This way you have the opportunity to change the settings, if necessary, and to save your 

documents in other formats as well. 

Appending PDF documents 

You can add pages to existing PDF documents. 

• Select PDF as output format. 

• Click the PDF output format button. 

• Select an existing PDF document and click Save. 

• Readiris now asks you whether to append or overwrite the existing file. 

• Select Append to add the pages to the document. 

 

Starting a new project in Readiris 

To start a new project in Readiris: 

• Click the trash can Delete All icon at the bottom of the Pages panel. 

This command erases your document from Readiris so you can start a new one. 
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Available Output Formats 

Below you find an overview of the supported output formats. 

• PDF 

PDF stands for "Portable Document Format". It is a format developed by Adobe Systems Inc. to 

facilitate document exchange. PDF files are device-independent and resolution-independent, and can 

be opened on any Operating System (Windows, Mac OS, Linux, iOS, Android, etc.) PDF files are 

mostly used for storage purposes. Note that the content of PDF files cannot be edited (easily). 

With Readiris you can generate 4 types of PDF files: 

o PDF Image-Text (= PDF Searchable Image) This file type is most commonly used. It 

contains two layers: the recognized text, and the original image on top of the text. This way, 

you have both access to the recognized text and you still see the original image. 

Note: since the image covers the text, any recognition mistakes will not be visible. 

o PDF Image. When you select this file type, Readiris doesn't execute the text recognition on 

your document. Your PDF file will not be text-searchable, it only contains the image of your 

original document. 

o PDF Text-Image (Readiris Corporate only). This file type is the opposite of PDF Image-

Text. It contains the original image in the background, and the recognized text on top of the 

image. 

Note: any recognition mistakes will be visible in this format. 

o PDF Text (Readiris Pro and Corporate). This file type contains the recognized text, but 

does not contain the original image of your document. Any images in the original document 

are included as graphics in the PDF file.   

Note: many options are available for PDF files. Readiris can generate hyper-compressed PDF files, 

password-protected PDF files, digitally signed PDF files, PDF/A-compliant PDF files. See the section 

Selecting the PDF Options for more information. 

Tip: with Readiris you can also turn Image PDFs into text-searchable PDFs. 

  

• XPS 

XPS stands for XML Paper Specification. It is a fixed-layout document format designed by Microsoft 

Inc. to preserve document fidelity. XPS files - just like PDF files - are mostly used for storage 

purposes. Note that the content of XPS files cannot be edited (easily). 

With Readiris you can generate 4 types of XPS files: 

o XPS Image-Text. This file type is most commonly used. It contains two layers: the 

recognized text, and the original image on top of the text. This way, you have both access to 

the recognized text and you still see the original image. 

Note: since the image covers the text, any recognition mistakes will not be visible. 

o XPS Image. When you select this file type, Readiris doesn't execute the text recognition on 

your document. Your XPS file will not be text-searchable, it only contains the image of your 

original document. 

o XPS Text-Image (Readiris Corporate only). This file type is the opposite of XPS Image-

Text. It contains the original image in the background, and the recognized text on top of the 

image. 

Note: any recognition mistakes will be visible in this format. 

o XPS Text (Readiris Corporate only). This file type contains the recognized text, but does 

not contain the original image of your document. Any images in the original document are 

included as graphics in the XPS file.   
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Note: Readiris can also generate hyper-compressed XPS documents. See the section Selecting the 

XPS Options for more information. 

  

• RTF 

RTF stands for "Rich Text Formatting". It is a free document file format developed by Microsoft Inc. to 

facilitate document exchange. Most text processors, such as Microsoft Word, are able to read and 

write RTF documents. 

Again many levels of lay-outing are available. See the section Selecting the Formatting Options for 

more information. 

  

• DOCX 

DOCX is the standard text processor format used since Microsoft Word 2007. This file format is based 

on the XML (extensible markup language) format. 

The same layouting options are available as for DOC and RTF documents. See the section Selecting 

the Formatting Options for more information. 

  

• DOC 

Doc was the standard format used up Microsoft Word 2003. 

Note that many levels of layouting are available for .doc documents. See the section Selecting the 

Formatting Options for more information. 

Note that Microsoft Word must be installed on your computer in order to generate DOC files. 

  

• ODT 

ODT stands for "Open DocumentText". It is an open-source file format. 

ODT files can be opened with any OpenOffice-compatible text processor. 

See the section Selecting the Formatting Options for more information about the available layout 

options. 

  

• Spreadsheet ML (xml) 

SpreadsheetML is an XML dialect developed by Microsoft Inc. It is the standard spreadsheet format in 

Microsoft Excel 2003. This format is useful when processing documents with lots of tables and 

figures. 

Specific layouting options are available for SpreadsheetML. See the section SpreadsheetML Options 

for more information. 

  

• XLSX 

XLSX is the standard spreadsheet file format used since Microsoft Excel 2007. XLSX files are created 

using the Open XML standard. Each cell in an XLSX file can have a different formatting. 

See the section Selecting the Formatting Options for more information about the available layout 

options. 
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• CSV 

CSV stands for "Comma Separated Value". It is a text format for storing tabular data. In a CSV file 

commas are used to separate values. This format is usually associated with Microsoft Excel on 

Windows computers. 

  

• TXT 

A TXT file is a standard text document that contains unformatted text. TXT files can be opened in any 

text editing or word processing application. 

No Layout options are available for TXT files. 

  

• HTML 

HTML stands for "Hypertext Markup Language". It is the predominant markup language for web 

pages. It provides a means to describe the structure and formatting of text-based information in a 

document. This file format can be opened in Microsoft Excel, in Web browsers such as Internet 

Explorer, and in Web page editors such as Adobe Dreamweaver.   

See the section Selecting the Formatting Options for more information about the layout options. 

  

• TIF 

TIF stands for "Tagged Image File". It is a high-quality graphics format that is often used for storing 

images with many colors. 

Select this format if you want Readiris to convert your documents into image files. No text 

recognition will be done on your documents. 

  

• JPG 

Jpeg stands for the "Joint Photographic Experts Group". It is a compression standard for digital 

images that is optimized for use on the Internet. It offers a good ratio between image quality and 

storage size. 

Saving as JPEG format allows one page/image per file only.  

  

• EPUB 

EPUB is a free and open e-book standard by the International Digital Publishing Forum (IDPF). EPUB 

is designed for reflowable content, meaning that the presentation of the content automatically adapts 

itself to the device on which it is opened. EPUB also supports fixed-layout content. 

Note that Readiris only creates body text in EPUB files. Images are not included. 

  

• WAV / MP3 

WAV stands for Waveform Audio File Format. It is a Microsoft and IBM audio file format. 

MP3 stands for Moving Picture Experts Group Layer-3 Audio. That format uses data compression so 

that it reduces the size of the file. 

When you save the recognition results in those formats you can listen to the text thanks to a media 

player (results as Text to Speech) 

By default, Windows is using a 'voice' that comes with your Windows interface configuration 

(Settings/Time & Language/Region & language/languages). For more voices and/or 

languages, refer to the Windows Help. 
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Notes:  

• a number of older file formats are supported as well. 

• RTF files created by Readiris can also be opened in the web-based office applications. When using 

such applications make sure to select the layout option Retain Word and Paragraph 

Formatting. 
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Adding Properties to Documents 

The documents you process can be complemented by properties. This means you can apply key "tags" to 

your documents, such as the author, the document type, the scanning date, etc. This way, you can retrieve 

them more easily once they have been stored. 

To add properties to documents: 

• Scan or open your documents into Readiris. 

• Select the desired output format from the Output File group. 

• Make sure the option Save as file is activated in the selected output format settings. 

 

• Click the selected output format button to save your documents. 

• In the Output File window that opens, click Properties to add properties to your documents. 

 

 

• Fill in the properties, then click OK to save them. 
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Saving Scanned Documents as Image Files 

The documents you scan do not necessarily need to be converted into text output files. You can also choose 

to save them as optimized image files. 

To do so: 

• Scan or open your documents in Readiris. 

 

• Then click the Page tab: 

o Click Save Pictures to save only the picture zones to an image file. 

o Click Save Full Page as Image to save the current page as an image file, or; 

o Click Save All Pages as Image to save all the pages in Readiris as image file(s). 

Note: with this third option, you can choose to save all pages to a multipage image files, or 

save each page separately in separate image files. 

 

• Name your document and select as which type of image you want to save it. 

 

• Depending on the image format you select, a JPEG quality slider may be available. With this slider 

you can determine the quality of your image files. 
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Selecting the Formatting Options 

Depending on the output format you select in the Output window, different formatting options are 

available. 

 

Below you will find a short description of each Options group. See the corresponding sections below for 

more detailed information.  

 

Layout Options 

The Layout Options play an important role when generating Word processor documents, Spreadsheet 

documents and Web page documents. They determine for a large part what your final documents will look 

like. 

General Options 

The General Options are available for each output format on which Readiris does text recognition. When 

you select an image output format, such as PDF Image, or TIF, for instance, the General Options are not 

available. 

The General Options complement the Layout Options and determine, amongst others, if the colors and 

graphics are maintained in the output documents. 

SpreadsheetML Options 

When generating SpreadsheetML documents for Microsoft Excel (2007 and higher), dedicated 

SpreadsheetML Options are available, besides the Layout and General Options. 

The SpreadsheetML Options determine how the worksheets will be formatted in your Excel document. 

PDF Options 

When generating PDF documents, only the specific PDF Options are available. These include bookmarking, 

iHQC-compression, password protection and digital signing. 

XPS Options 

When generating XPS documents, only the specific XPS Options are available. These include bookmarking 

and iHQC compression. 
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Paper Size 

The Paper Size options allow you to define in which paper size (e.g. A4, Letter, Legal) your output 

documents will be generated. 

These options are available for most RTF output formats. 

Pictures 

The Pictures Options determine how the pictures will be presented in the output documents, e.g. in black-

and-white or in color. They also define their resolution. 

Note: when you select an output format or application that does not support images, then the Pictures 

Options will be unavailable in Readiris. 

Text To Speech 

In the Text To Speech options you can select the voice and language in which the recognition results will be 

read. 
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Layout Options 

The Layout Options play an important role when generating Word processor documents (.doc, .docx, .rtf, 

.odt), Spreadsheet documents (.xml, .xlsx) and Web page documents (.htm). They determine for a large 

part what your final documents will look like. 

Below you find a description of what each Layout option does and examples of real documents. Also notice 

the thumbnail on the right side of the window. It gives you a general idea of the document layout based on 

the Layout option you select. 

Note: the Layout tab is of course unavailable when you select PDF, XPS or TIF as output format. 

PDF and XPS are fixed-layout formats and by default re-create the original layout of the document. 

And TIF is an image format, on which no recognition is done. 

Note: if any Layout option is unavailable for the output format you selected, this means the option in 

question is not supported. 

 

• The option Create body text generates a continuous, running line of text. The result is a document 

without any formatting. The formatting is to be done manually, by the user. 

Example of body text 

 

 

• The option Retain word and paragraph formatting keeps the general format structure of your 

scanned document. 

The font type, size and type style are maintained across the recognition process. 

The tabs and the alignment of each block are recreated. 

The text blocks and columns aren't recreated; the paragraphs just follow each other. 

Tables are recaptured correctly. 

Pictures are not captured. 
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Example of word and paragraph formatting 

 

 

• The option Recreate source document tries to stay as close to the original layout as possible. 

The text blocks, tables and pictures are re-created in the same place as the original. 

The word and paragraph formatting are maintained. 

Hyperlinks are re-created too. 

Example of a re-created source document 

 

o The option Use columns instead of frames creates columns instead of text frames to 

position the information on the page. 

Columnized texts are easier to edit than documents containing multiple frames: the text 

flows naturally from one column to the next. 

Note: should Readiris be unable to detect columns in the source document, then frames 

are still used as substitute solution. 

Tip: use this option when generating Word documents. 

o The option Insert column breaks inserts a hard column break at the end of each column, 

which maintains the format of the text. Any text you edit, add or remove remains inside its 

column; no text flows automatically across a column break. 

Tip: disable this option (Insert column breaks)  when you have body text that 

contains columns. You'll ensure the natural flow of the text from one column to the next. 

o The option Add image as page background places the scanned image as page background 

beneath the recognized text. 
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Note: this option increases the file size of the output files substantially. 

The format PDF Text-Image modifies PDF files in the same manner. 

To avoid the file increase discussed above, select the option Retain colors of 

background on the Options tab. This provides a similar but less drastic, more compact 

alternative. 
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General Options 

The General Options are available for each output format on which Readiris does text recognition. When 

you select an image output format, such as PDF Image, or TIF, for instance, the General Options are not 

available. The General Options complement other options such as the Layout and SpreadsheetML Options. 

Note, however, that some general options are unavailable depending on the other Formatting options you 

select. 

Below you find a description of what each option does and examples of real documents. 

 

• The option Merge lines into paragraphs enables automatic paragraph detection. 

Readiris wordwraps the recognized text until a new paragraph starts, and reglues hyphenated 

words at the end of a line. 

• The option Include pictures does exactly what it says; it includes images in your output 

documents. 

Clear this option in case you only need lay-outed text. 

• The option Maintain colors of text keeps the original color of the text in your source documents. 

• The option Maintain colors of background recreates the background color of each document. 

Note: in a spreadsheet application, this option recreates the background color of each cell. 
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SpreadsheetML Options 

When you select Microsoft Excel 2007, 2010 (SpreadsheetML) as output format, specific 

SpreadsheetML options are available. 

Below you find a description of what each option does and examples of real documents. 

 

 

• The option Ignore all text outside the tables saves the tables and ignores all other recognition 

results. 

All data inside the tables is recaptured; any data outside the tables is not. 

Example image   

   

• The option Convert figures into numbers encodes recognized figures as numbers. 

As a result, you can execute arithmetical operations on those cells. The text cells (in any table) 

remain text. 

Note that only figures inside tables are encoded as numbers. 

• The option Create one worksheet per page sees to it that one worksheet is created per scanned 

page. 

If a page contains tables and text, all is placed inside the same worksheet. 

• The option Create one worksheet per table places each table in a separate worksheet and 

includes the recognized text (outside the tables) in another worksheet. 

If the document being processed contains more than one page, each page will be processed in 

the same manner. 

This option is useful when processing tables of different sizes and different headings. 
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Paper Size 

The Paper Size options allow you to define in which paper size (e.g. A4, Letter, Legal) your output 

documents will be generated. These options are available for most rich text output formats. 

 

• Click the Paper size tab and use the arrow buttons to apply and exclude paper sizes. 

• Readiris will go through the active paper sizes in the user-set order and will use the first paper size 

that is sufficiently large to hold the scanned document. 

Note: the default paper sizes vary depending on your operating system settings. 
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Pictures 

The Pictures Options determine how the images will be presented in the output documents, e.g. in black-

and-white or in color. They also define their resolution. 

Note: when you select an output format or application that does not support images, then the 

Pictures options will be unavailable in Readiris. 

Below you find a description of what each option does. 

 

• Black-and-white images 

Readiris by default saves images in color. Select this option to generate black-and-white 

images. The colors of the text inside your documents can still be maintained. 

• Maintain scan resolution 

This option is activated by default. Readiris generates the output documents in the same 

resolution as your scanned documents. To verify in which resolution your documents have been 

scanned, check the Scanner Settings. Or point to a page thumbnail to view its properties. 

 

• Reduce resolution to: 

If you don't want to maintain the original scan resolution, then select the option Reduce 

resolution to, and indicate to which resolution you want to reduce the images. 

Note: it is recommended to use a resolution of at least 72dpi. 

• JPEG quality 

Images stored inside PDF, XPS, Word and RTF documents are saved in the JPEG format. 

Use the slider to adjust the JPEG quality. 

• JPEG 2000 compression 

When saving files in the PDF or XPS format, Readiris can apply JPEG 2000 compression to the 

color-grayscale images stored inside those files. 
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Selecting the PDF Options 

Selecting the PDF Options 

The documents you process with Readiris can be saved as PDF documents. 

About PDF documents 

PDF stands for "Portable Document Format". It is a format developed by Adobe Systems Inc. to facilitate 

document exchange. PDF files are device-independent and resolution-independent, and can be opened on 

any Operating System (Windows, Mac OS, Linux, iOS, Android, etc.) PDF files are mostly used for storage 

purposes. Note that the content of PDF files cannot be edited (easily). 

To save documents as PDF documents: 

• Select PDF in the Output group, and then click the down arrow beneath it to configure the settings. 

Or if PDF is not displayed in the Output group, click Other. 

 

• Select the desired PDF type from the drop-down list: 

 

• PDF Image-Text (= PDF Searchable Image). This file type is most commonly used. It contains 

two layers: the recognized text, and the original image on top of the text. This way, you have both 

access to the recognized text and you still see the original image. 

Note: since the image covers the text, any recognition mistakes will not be visible. 

• PDF Image. When you select this file type, Readiris doesn't execute the text recognition on your 

document. Your PDF file will not be text-searchable, it only contains the image of your original 

document. 

• PDF Text (Readiris Corporate only). This file type contains the recognized text, but does not 

contain the original image of your document. Any images in the original document are included as 

graphics in the PDF file.   

• PDF Text-Image (Readiris Corporate only). This file type is the opposite of PDF Image-Text. It 

contains the original image in the background, and the recognized text on top of the image. 

Note: any recognition mistakes will be visible in this format. 
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The PDF options 

 

Create bookmarks 

Bookmarks are types of links inside a PDF document, which contain representative information about the 

section they are linked to. Bookmarks give structure to your PDF documents. They are grouped in the 

Bookmarks panel in the Navigation pane. 

In Readiris, the option Create bookmarks creates a bookmark for each text zone, image zone and table 

zone inside a PDF file. 

  

Embed fonts 

The option Embed fonts, embeds - or includes - the original fonts of your documents in the PDF file. This 

way, other users will always see the documents in their original fonts on their computer, even if they don't 

have the particular font you used installed on their computer. 

Note that embedding fonts increases the file size of your output documents. 

  

Create PDF/A fully compliant files (Readiris Corporate) 

This option generates PDF files that are suited for long-term archiving. PDF/A stands for "Portable 

Document Format Archivable". PDF/A files contain only what is strictly needed for opening and viewing 

them. 

  

Fast WEB View 

The option Fast WEB View restructures a PDF document for page-per-page downloading from web 

servers. This option is useful when accessing the documents you sent to the Cloud. 

  

PDF - intelligent High-Quality Compression 

In Readiris you also have the possibility to compress your PDF documents. Refer to the separate section 

Compressing PDF documents for more information.   

  

Tip: also see the section Password-protecting PDF documents and Digitally signing PDF documents. 
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Compressing PDF documents 

The PDF documents you generate with Readiris can be hyper-compressed by means of iHQC. iHQC stands 

for intelligent High-Quality Compression, I.R.I.S.' proprietary, efficient compression technology. iHQC 

is to images what MP3 is to music and what DivX is to movies. 

To generate compressed PDF documents: 

• Select PDF in the Output group, and then click the down arrow beneath it to configure the settings. 

Or if PDF is not displayed in the Output group, click Other. 

 

• Select the required PDF type from the drop-down list. 

Note that iHQC compression is unavailable for PDF Text and PDF Text-Image files. 

 

• Select the required compression level: there are three levels of compression. 

For each level there are two types of compression: Good Size and Good Quality. Good Size offers 

the best compression, with a minimal loss of image quality. Good Quality offers slightly larger output 

files with better image quality. 

 

Notes: 

In Readiris Pro you can select Level I - Good Size, and Level I - Good Quality.  

In Readiris Corporate you have access to all levels of iHQC. 
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Customized Compression (Readiris Corporate) 

In Readiris Corporate you can also select Custom compression. When you select this option, you can 

determine the Size/Quality ratio yourself by means of a slider. 

 

The option Compress symbols is selected by default. This option compresses text inside your documents. 

The option Wavelet compression is also selected by default. This option compresses images inside your 

documents. 
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Password-protecting PDF Documents 

(This section applies to Readiris Corporate only) 

The PDF documents you generate with Readiris can be password-protected. You can set a password to 

open the documents, and a password that restricts modifications to the documents. 

To password-protect PDF documents: 

• Select PDF in the Output group, and then click the down arrow beneath it to configure the settings. 

Or if PDF is not displayed in the Output group, click Other. 

 

• Select the required PDF type from the drop-down list. 

• Then click the Password tab. 

 

• When you set an open document password, you will be prompted to enter that password when 

opening the PDF output. 

• When you set a permissions password, you will only be able to perform the actions specified in 

the security settings. If you do want to change these settings, you must enter the permissions 

password. 

The Readiris security settings are similar to the standard protection features offered by Adobe Acrobat. 

Note that in Readiris the open document password and permissions password must be different. 
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Digitally Signing PDF Documents 

(This section applies to Readiris Corporate only) 

The PDF documents you generate with Readiris can be digitally signed. Digital signatures identify the 

person who created the PDF documents; they authenticate the identity of the author, certify a document 

and help prevent unwanted changes to PDF documents. 

Note, however, that Readiris does not generate digital signatures. You need to have a digital signature at 

your disposal to generate signed documents with Readiris. You can create digital signatures with Adobe 

Acrobat or obtain them from companies like VeriSign. 

To generate digitally signed documents: 

• Select PDF in the Output group, and then click the down arrow beneath it to configure the settings. 

Or if PDF is not displayed in the Output group, click Other. 

• Select the required PDF type from the drop-down list. 

• Click the Signature tab to access the signing options. 

• Select Use this signature then browse for the signature of your choice. 

 

Tips: 

If you don't see any signatures in this list, click the Manage button. Then click Import and follow the 

instructions in the Certificate Import Wizard. 

You can also use the options behind the Manage button to edit, remove or export any digital signatures on 

your PC. 

Click the Details button to display all available information on your current signature. 

See the Adobe documentation for more information about certificates. 

When you use a digital signature, it appears in the Signatures tab of Adobe Acrobat and Adobe Reader. 
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Selecting the XPS Options 

Selecting the XPS Options 

The documents you process with Readiris can be saved as XPS documents. 

About XPS documents 

XPS stands for XML Paper Specification. It is a fixed-layout document format designed by Microsoft Inc. to 

preserve document fidelity. XPS files - just like PDF files - are mostly used for storage purposes. Note that 

the content of XPS files cannot be edited (easily). 

To save documents as XPS documents: 

• Click Other in the Output group. 

 

• Select the desired XPS type from the drop-down list: 

 

• XPS Image-Text. This file type is most commonly used. It contains two layers: the recognized 

text, and the original image on top of the text. This way, you have both access to the recognized 

text and you still see the original image. 

Note: since the image covers the text, any recognition mistakes will not be visible. 

• XPS Image. When you select this file type, Readiris doesn't execute the text recognition on your 

document. Your XPS file will not be text-searchable, it only contains the image of your original 

document. 

• XPS Text (Readiris Corporate only). This file type contains the recognized text, but does not 

contain the original image of your document. Any images in the original document are included as 

graphics in the XPS file.   

• XPS Text-Image (Readiris Corporate only). This file type is the opposite of XPS Image-Text. It 

contains the original image in the background, and the recognized text on top of the image. 

Note: any recognition mistakes will be visible in this format. 
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The XPS Options 

 

Create bookmarks 

Bookmarks are types of links inside an XPS document, which contain representative information about the 

section they are linked to. Bookmarks give structure to your XPS documents. 

In Readiris, the option Create bookmarks creates a bookmark for each text zone, image zone and table 

zone inside a XPS file. 

XPS - intelligent High-Quality Compression 

In Readiris you also have the possibility to compress your XPS documents. Refer to the separate section 

Compressing XPS documents for more information. 
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Compressing XPS Documents 

The XPS documents you generate with Readiris can be hyper-compressed by means of iHQC. iHQC stands 

for intelligent High-Quality Compression, I.R.I.S.' proprietary, efficient compression technology. iHQC 

is to images what MP3 is to music and what DivX is to movies. 

To generate compressed XPS documents: 

• Click Other in the Output group. 

 

• Select the required XPS type from the drop-down list. 

Note that iHQC compression is unavailable for XPS Text and XPS Text-Image files. 

 

• Select the required compression level: 

For Level I there are two types of compression: Good Size and Good Quality. Good Size offers the 

best compression, with a minimal loss of image quality. Good Quality offers slightly larger output files 

with better image quality. 

 

In Readiris Corporate you can also select Custom compression. When you select this option, you 

can determine the Size/Quality ratio yourself by means of a slider. 
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Section 10: Sending Documents to the Cloud 

The documents you process with Readiris can be sent to various Cloud applications. With Readiris Pro you 

can send documents to Evernote, Dropbox, Google Drive, OneDrive and box. With Readiris Corporate you 

can also send documents to Microsoft SharePoint, Therefore, IRISNext and FTP. 

Before you can export to the Cloud, the connections must be configured. 

Important note: in order to configure a connection, you need a valid Dropbox, Google Drive, Evernote, 

box, OneDrive, SharePoint, Therefore, IRISNext or FTP account. 

Important note (Readiris Corporate): when using Therefore, an up-to-date Therefore Client must be 

installed and configured correctly on your computer. 

Configuring the Connectors 

• Click the Cloud Setup tab, then click the Cloud application of your choice. 

 

Evernote, Dropbox, box, OneDrive, Google Drive 

• Click Browse. 

An OAuth Authentication window opens. 

• Enter your credentials and click Sign in / Authorize. 

• Select the option that allows IRISConnect to access your account. 

 

Example from Evernote 

• Select the required folder. 

Note: if you keep the following option selected "Ask for confirmation before exporting" you 

will always need to indicate the export folder when processing documents. To avoid this step, 

clear this option. 

• Click OK to finish the configuration. 
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SharePoint, Therefore, IRISNext 

• Enter your Username and Password. 

• Enter the SharePoint Server to connect to. 

• Then click Browse. 

• Select the required folder to export to. 

• If necessary, select Content Type. 

Note: if you keep the following option selected "Ask for confirmation before exporting" you 

will always need to indicate the export folder when processing documents. To avoid this step, 

clear this option. 

• Click OK to finish the configuration. 

  

FTP 

• Enter your Username and Password. 

• Enter the FTP address in the Server field. 

• Enter the Path if necessary. 

• Proxy host: if your FTP server is running behind a firewall that requires an SSL proxy to connect to 

an outside server, enter the proxy host name in this field. If you can connect correctly to the 

Internet from your computer, leave this field blank. 

Sending Documents 

• Scan or open your documents, and select the required processing settings. 

• In the Output File group, click Other and select the Cloud application you configured. 

 

• Then click the required output format button to send your documents to the Cloud. 

• You are prompted to indicate where exactly on your Cloud system the documents must be exported. 

Indicate the location, and then click on OK. 

Tip: clear the option Ask for confirmation before exporting if you do not want to 

indicate the location again in the future. 

 

• You are then prompted to name your document. Name the document and click OK to complete the 

export. 
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Sending Indexed Documents to the Cloud 

(This section applies to Readiris Corporate only) 

When sending documents to a Cloud location, Readiris automatically detects if the Cloud location has any 

mandatory index fields that need to be filled in. 

 

Example of mandatory SharePoint fields 

To send indexed documents: 

• Configure one of the Cloud connectors that supports indexes: SharePoint, Therefore or IRISNext. 

See Sending Documents to the Cloud if necessary. 

• In the Output File group click Other and select the connector you configured. 

• Click OK. 

• Return to the Output File group, click the down arrow beneath the output file format you previously 

selected and select User Index. 

Note: If you leave the User index unselected, Readiris only displays any mandatory index 

fields when sending your documents. 

 

• Process your documents and click the desired output file format to send them. 

The (mandatory) index fields are displayed on the Index tab. 

 

• Now you can either fill in the index fields manually, OR 

• Use Readiris' Drag-and-Drop recognition technology to fill them in: 

o Click inside a field you want to fill in. 

o Then click the Text icon to recognize text zones, or click the Barcode icon to recognize 

barcode zones. 

o Draw a frame around the zone you want to use as index. When you release the mouse 

button, the text is filled in in the field. 

• Click the desired output file format to send the indexed documents, or click Discard to start over. 
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How to configure your scanner in Readiris 

In order to scan documents in Readiris, your scanner must be configured correctly: 

1. Make sure your scanner is connected to your computer, and switched on. 

Note: the scanner should be physically connected to your computer with a USB cable. An Ethernet or 

wireless connection may also be used if the Twain driver supplied by the manufacturer has been 

engineered with that capability. 

2. Make sure you have the latest available Twain driver installed for your scanner. 

In general, drivers can be found on the website of your scanner manufacturer. They are not provided 

by I.R.I.S. Note that some scanner drivers may not work under the latest versions of Windows. See 

the documentation supplied with your scanner to find out which platforms are supported. If 

necessary, contact your scanner manufacturer. 

  

Scanner configuration in Readiris 

Readiris will try to detect automatically an installed scanner, its driver and will do an automatic 

configuration of any other needed settings such as resolution, paper format, etc. 

The automatic scanner detection is currently possible for an installed I.R.I.S., Canon, and HP device. 

For any other device, you have to do a manual configuration. 

  

Automatic scanner detection 

• This feature is activated when you click the Scan button 

o the first time you use an installed scanner 

or 

o after a Restore Factory Settings operation 

 

• A Scanner detection message is displayed. 

o To confirm the automatic detection action, click OK. 
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• When clicking OK, Readiris starts the matching process. It tries to match the installed scanner with 

a scanner model or profile of the list of validated scanners in Readiris. 

For the time being, this list consists mainly of Canon, HP and IRIS devices. 

• If Readiris detects a match, it proposes the corresponding scanner profile in the Scanner model 

window. 

  

In this example, a Canon MF416dw MFP device is configured and Readiris proposes Canon MF410 series 

 

• To confirm the proposed device as the current model to be used in Readiris, click OK. 

If Readiris cannot find your scanner model, go to the Manual scanner detection section. 

• Readiris will, then, load the corresponding TWAIN driver installed on the system, and display the 

Scanner setting window pre-filled with the scanner capabilities, such as resolution, paper format, 

etc. 
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• To start scanning, click OK. 

For more information about the different scanner settings, see the topic Selecting the Scanner Settings. 

 

Manual scanner detection 

• If Readiris cannot find automatically your scanner model, select it manually in the Scanner model 

list. 

In this list you select your scanner profile. The scanner profile allows you to access features specific 

to your scanner. For example, duplex scanning. 

Do not worry if you don't see your scanner in the list; not all scanners have specific scanner profiles. 

Important note: in case you don't find the exact same profile, do not select a profile that 

resembles it. Instead, select a universal Twain profile. Different Twain profiles are available: 

Select <Twain><OTHER MODELS> when you are using a regular, flatbed scanner. 

Select <Twain><OTHER MODELS>(User interface) if you want to use your scanner user 

interface to scan documents. 

Select <Twain><OTHER MODELS with duplex feeder> when you are using a duplex 

scanner, which scans both the front and backside of a page. 

 

• Once you have selected a scanner model, you must configure your scanner driver. 

o Click Configure to select your scanner driver. 

If you do not see your scanner listed in the Select Source window, then your scanner driver 

has not been installed properly. Re-install your scanner driver before trying to configure it in 

Readiris. The scanner driver can usually be found on the website of your scanner manufacturer. 

 

 

Note: you can also configure the scanner driver directly on the main toolbar. Just click the 

down arrow beneath Scan and click Select Source. 

• Once the scanner has been configured you can start scanning, using the default scanner settings. 

For more information about the different scanner settings and how to change them, see the topic 

Selecting the Scanner Settings. 
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How to obtain good recognition results 

The "try again" triangle symbol indicates one or more problems with the recognition of your documents. 

 

  

The quality of the recognition results depends on a number of factors and you're advised to check the 

following points: 

• the document language 

Make sure you select the right Document Language in the Acquire group. See the section 

Recognition Options for more information. 

• the quality of the scanned documents 

If the scanned documents are too bright, or too dark, Readiris will have trouble recognizing them. 

Luckily there is a feature that allows you to adjust the quality of scanned documents. See the section 

Adjusting the Image Quality to learn how to do so. 

• the rotation of your image 

Make sure the imported image has the right rotation. If not, use the Rotate tool in the Home tab. 

• the resolution of your imported images 

If you are using a scanner to scan documents, the image quality is also linked to the scanner 

settings. See the section Selecting the Scanner Settings to make sure the right settings have been 

selected for your scanner. 

Make the scan resolution is set to 300 dpi for regular documents and to 400 dpi for small print and 

Asian languages. 

  

Please note that an image of very poor quality will not be correctly recognized even after verification of the 

above points. 
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How to scan multiple documents 

In Readiris there are a number of features that allow you to scan and process multiple documents easily in 

Readiris. 

Scanning multiple documents on a flatbed scanner 

• Click the down arrow beneath the Scan button to access the Settings. 

 

• In the Scanner window, select Scan another page after and then indicate after how many 

seconds the next page must be scanned. 

This way, you avoid having to go back to your computer and click the Scan button inside Readiris. 

You can simply replace the pages at your own pace and Readiris starts scanning the next page 

automatically. 

 

Scanning multiple documents on a scanner with a document feeder 

• Click the down arrow beneath the Scan button to access the Settings. 

• In the Scanner window, select ADF (automatic document feeder). 

This way you can scan one page after the other on your scanner and Readiris will keep up. 
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How to process digital camera images 

Readiris uses special recognition routines to process digital camera images. Make sure the Digital Camera 

option is activated when processing such images. 

The Digital Camera option can be activated both in the scanner Settings and the From File options. 

In the scanner Settings: 

• First of all, turn on your digital camera and connect it to your computer with a usb cable. 

• In Readiris, click the down arrow beneath the Scan button, then click Settings. 

• Click Scanner Model and select <Twain><Other models> from the list. 

• Then click Configure and select your camera's Twain driver. 

Note: if you don't see your driver in the Select Source list, this means the driver has not been 

installed correctly or your camera does not have a Twain driver. Consult your camera's 

documentation if necessary. 

Tip: if you don't have a Twain driver, you can always open your camera images From File. 

• Return to the Scanner Settings window and select the Digital Camera option. 

• When you click Scan in Readiris your camera will now make a scan. 

In the From File options: 

• Turn on your digital camera and connect it to your computer with a usb cable. 

• In Readiris, click From File. 

• Select the Digital Camera option. 

• Browse for your digital camera's memory and select the files you want to open. 

  

Note: after you have scanned or opened digital camera images, use the 3D Correction feature to optimize 

them. See below. 

Tips for taking pictures with your digital camera 

• Calibrate the camera by photographing a white document (before using it with Readiris) 

• Always select the highest image resolution. 

• Enable the macro mode of the camera to take close-ups. 

• Enable the document mode of the camera (if any). 

• Only use optical zoom, not digital zoom. 

• Hold the camera directly above the document. Avoid photographing documents at an angle. 

Tip: in case the angle should not be correct, you can correct it using the 3D Correction 

feature. See Section 7: Editing the Recognized Documents > Modifying the Page Options > 3D 

Correction. 

• Produce stable images. Use a tripod if necessary. 

• Disable the flash when photographing glossy paper. 

• Avoid opening compressed camera images. 

• Adapt the Readiris brightness and contrast settings to the environment (daylight, lamp light, neon 

light). See Selecting the Scanner Settings. 

• Select color or grayscale as color mode in Readiris. Also see Selecting the Scanner Settings. 
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How to recognize barcodes 

(This section applies to Readiris Corporate only) 

In Readiris Corporate you can recognize barcodes. Barcodes can be used to separate documents in a 

batch. 

   

 

Note: Readiris supports most widespread 2D barcodes. Readiris supports laser printed and inkjet printed 

barcodes. 

To define which barcodes Readiris should recognize: 

• Click the Readiris button, and then click Advanced Settings. 

• Click the Barcodes tab. 

• Select the barcode types you want Readiris to recognize. 

 

Important: Readiris automatically recognizes barcodes to separate documents, but the barcodes zones 

themselves are not recognized as barcodes. In most case, they are recognized as images. 

Recognizing barcodes manually: 

• Scan or Open your document. 

• Click the Zones tab. 

• Click the Barcode icon and draw a frame around the barcode. 

• OR right-click the barcode zones that are incorrectly recognized as image, then point to Zone > 

Type and select Barcode. 

• Then go to the Output File group and configure the output settings to save or send your document. 

Recognizing a particular barcode 

In case you need to use the content of a particular barcode: 

• Draw a barcode zone around the barcode. 

• Then right-click inside the zone and click Copy as Data. 

The content of the zone is copied to the Clipboard. You can now paste it in other applications.  
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How to separate document batches 

(This section applies to Readiris Corporate only) 

When you are scanning entire stacks of paper - on a scanner equipped with a document feeder for instance 

- it can be useful to indicate where one document ends and another begins. That way, Readiris can 

generate a separate output file for each document. This avoids your having to scan only one document at a 

time. 

Example 

Let's say you are scanning a stack of 30 pages. The first 10 pages belong to Document 1, pages 11 to 20 

belong to Document 2 and pages 21 to 30 belong to Document 3. If you indicate that your stack of paper in 

fact contains 3 documents, Readiris will generate 3 separate output files. 

  

How to separate paper documents 

With Readiris, there are two ways in to separate paper documents. You can do this by means of: 

• blank pages 

In this case you simply put a blank page between two sheets of paper to indicate where the new 

document begins. 

• cover pages containing a barcode 

In this case you can, for instance, put a barcode sticker on each first page of a document. 

  

To access the document separation options: 

• Click the Readiris button, and then click Advanced Settings. 

• Click the Document Processing tab. 

 

• Indicate which separation method you are going to use: Detect blank pages or Detect cover 

pages with a barcode. 
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When you are using cover pages with barcodes, you can indicate where exactly on the page the 

barcodes are located, by means of a read zone. Once you have defined the read zone, Readiris will 

only search for barcodes in that specific area. 

Tip: in order to know the dimensions of the read zone, use the Coordinates function in 

Readiris: 

▪ Click the Zones tab, and select Coordinates. 

 

▪ Now move the cursor over the image to see the coordinates. 

You can also indicate specific content your barcodes contain. When you select this option, Readiris 

will only look for the content you specified. Other barcodes will be ignored as cover page. This feature 

is recommended if your documents contain barcodes on other pages as well, and not only on the 

cover pages. 

  

The Recognition options 

If your barcode cover pages also contain other content - besides the barcodes - which you want to include 

in your output documents, then select the option Include cover pages in output documents. 

 

The option Apply page analysis to cover pages splits the cover pages up into recognition zones, just 

like regular pages. 

By means of the option Apply layout to cover pages you can use one of your zoning templates to split up 

the cover pages into recognition zones. For more information on how to use zoning templates, see the 

section Using Zoning Templates. 

  

The Indexing options 

In case you want Readiris to generate an XML index file containing detailed information on the processed 

documents, select the option Generate an XML index. 
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How to separate batches of image files 

(This section applies to Readiris Corporate only) 

When you are processing batches of image files and do not want Readiris to convert them into a single 

output file, you can use the Split here command to separate them. 

To do so: 

• Import all the images you want to process. 

• In the Pages panel, indicate at which page you want Readiris to start a new document: 

o Select the page. 

o Then right-click it and click Split here. 

 

o The document is split into two different documents. 

 

o To cancel this action, right-click the split page and click again Split here. 
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Note: if you want the cover pages to be included in the output documents, select the corresponding 

Document Separation options: 

• Click the Readiris button 

• Then click Advanced Settings and click the Document Processing tab. 
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How to process low-resolution images 

A resolution of 300 to 400 dpi is required to obtain optimal results in Readiris. When you are faced with 

low-resolution images, the best thing you can do is re-can the images in an appropriate resolution. If that's 

not possible, there are few tips and tricks that help you obtain better results: 

Tip 1 

When scanning images of an unknown resolution or images of which the file header displays an 

incorrect resolution, make sure to select the option Process as 300 dpi: 

• Click the down arrow beneath the Scan button. 

• Then click Settings. 

• Select the option Process as 300 dpi. 

When this option is selected, Readiris treats the images as if they had a 300 dpi resolution. 

  

Tip 2 

When scanning images with a digital camera, make sure to select the Digital camera option: 

• Click the down arrow beneath the Scan button. 

• Then click Settings. 

• Select the option Digital Camera. 

  

Tip 3 (Readiris Corporate only) 

Make sure that favor Accuracy over Speed when processing low-quality documents: 

• Click the expansion arrow on the Acquire group. 

• Move the slider to Accuracy. 

  

Note: When you are processing low-resolution faxes, there is no need to take special measures. Readiris 

detects the typical fax resolutions 100 x 200 dpi (normal quality), 200 x 200 dpi (fine quality) and 200 x 

400 dpi (superfine quality) and preprocesses these images automatically to ensure optimal results. 
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How to do a right-click conversion 

You can select one or more 

o image files (.tif, .tiff, .jpg, .jpeg, .bmp, .png, .j2k, .j2c); 

o PDF files (.pdf); 

o Microsoft Office Word documents (.doc, .docx); 

o Microsoft Office Excel files (.xls, .xlsx); 

o Microsoft Office PowerPoint files (.ppt, .pptx);  

o rtf files (.rtf) 

in Windows Explorer and convert them to Word (.docx), PDF (.pdf) or Excel (.xlsx) by right-clicking 

them.  

 

Select other output file formats - Change your configuration 

Click Open with Readiris option if you want to 

• open your files directly in Readiris, 

• select another output file format, 

• change the settings of the selected output format. 

  

Name your output file 

If you selected 

• one file, your new document will have the same name as the selected file. 

• more than one files, Readiris will generate a single file containing the selected files with an 

alphabetical order. 

This new file will take the name of the folder containing the selected files. 

The Save As dialog window opens when a file with the same name already exists. 
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